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Partnerships (1065)

The basics of data entry for a partnership (1065) return are the same as for the 1040. 
Field- and screen-level help, shortcut keys, and navigation throughout data entry all 
function as they do in the 1040 package. See the Drake Software User’s Manual: Tax 
Year 2013 for the basics of using the program.

What’s New in Drake for Partnership Returns

Drake programs its tax software according to the latest IRS rules and regulations. The 
2013 program reflects all changes to credits and deductions, including discontinua-
tions. For details on new regulations for 2013, see the IRS instructions for Form 1065.

Calculation Results Window

Several new indicators of e-file eligibility are now available in the enhanced Calculation 
Results window in all Drake’s tax software packages. 

As always, a green check mark is displayed in the EF Status column of the Calculation 
Results window (see Figure 1) when the default product (Form 1120) is eligible for e-file, 
and a red X is displayed when the product has EF messages keeping it from being e-file-
eligible.

New EF indicators have been added to the Calculation Results window to tell you if a 
return has already been accepted, if it is being suppressed by an option you chose, if it is 
not e-file-eligible because you did not select it for e-file, or if a type of return is not avail-
able for e-file. The status of extensions is displayed for all packages now.

Figure 1: More indicators are now available in the EF Status column
Tax Year 2013 1
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For details on the Calculation Results window, see Chapter 6, “Return Results,” of the 
Drake Software User’s Manual: Tax Year 2013

Searchable Selector Field

The selector field, located at the bottom of all Data Entry Menus (Figure 2) can now 
search for screens by screen code, name, or keyword.

Figure 2: Searchable selector field

You can still enter a screen code, state abbreviation, or form number in the selector field 
and press ENTER to open a particular screen, but for those times when you can’t remember 
the screen code or form number or on which tab of the Data Entry Menu the screen is 
located, you can now search for the screen with keywords or phrases.

For details, see “Searchable Selector Field” in Chapter 3, “Basics,” of the Drake Software 
User’s Manual: Tax Year 2013.

Electronic 
Signatures 

(e-Sign)

Drake’s 2013 tax software supports electronic signature pads that allow taxpayers and tax 
preparers to digitally sign Form 8879-PE, IRS e-file Signature Authorization for Form 
1065. 

For details on e-Signature, see “Electronic Signatures” in Chapter 6, “Return Results,” of 
the Drake Software User’s Manual: Tax Year 2013.

Foreign 
Addresses

 Additional foreign address fields have been added to screens.

M-1 
Worksheet

Worksheet WK_M1C explains the depreciation and amortization adjustments flowing 
to Forms M-1 and M-3.

Screen D Lines have been changed to accommodate new Schedule D lines: 1a and 8a for trans-
actions in which basis has been reported to the IRS and no adjustments are required.

Contact 
information

New e-mail, cell phone number, and fax number fields have been added to screen 1. 
These fields are for reporting purposes only and are not included in the e-file record.

Bank 
Secrecy Act

Due to new U.S. Treasury Department regulations, all Bank Secrecy Act (BSA) forms 
must be completed online. This includes the FBAR, Report of Foreign Bank and Financial 
Accounts (formerly known as Form 90-22.1). In Drake, screen FBAR (or screen 9022) 
2 Tax Year 2013
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contains a link to the Financial Crimes Enforcement Network’s BSA e-Filing System’s 
website.

Bonus 
Depreciation

For the 2013 tax year:

• Assets placed in service in 2013 — 50% bonus depreciation

• Assets placed in service in 2014 — 0% bonus depreciation

Changing 
Accounting 

Method

For partnerships changing their accounting method, Form 3115 must be attached as a PDF 
file. We have included an EF message that will automatically generate the PDF button on 
the View mode toolbar so that the preparer can attach the form as a PDF. (For instructions 
on attaching a PDF to a return, see “The PDF Attachment Process” on page 43, read the 
Screen Help or the instructions on any PDF screen, or read the “Attaching a PDF Docu-
ment” article on the FAQ screen.)

See “Form 3115, Application for Change in Accounting Method” on page 55 for details 
on changing accounting methods.

Account 
Type - State

The Account Type drop lists on the Electronic Fund Withdrawal (PMT) screens, for 
differentiating between business and personal bank accounts when paying state taxes by 
direct debit. These fields are located at the bottom of the PMT screens. 

Required 
Fields

More fields that require completion before a return is eligible for e-file have been high-
lighted in blue (Figure 3) this year. You can change the colors at Setup > Colors and turn 
off the warnings at Setup > Options > Data Entry tab.

Figure 3: Required fields in blue

Sch M-1 
Worksheet

Worksheet WK_M1P was added to explain the adjustments flowing to the M-1 and M-3.

Rental Real 
Estate

A check box has been added to screen 8825 to indicate the health insurance premiums are 
part of the guaranteed payments made to the partners, and that these premiums are claimed 
as expenses for rental real estate.

Property 
Type Drop 

List

For clients with rental property, Rental real estate drop lists on screens 4797, 8825, K1F, 
and K1P indicate how the rental property will be listed on the K1_8825 worksheet. The 
names of these drop lists vary: Property Type on screen 4797, Type of property on 
screen 8825, Rental real estate income (loss) on the K1P screen, and Net rental real 
estate income (loss) on the K1F screen.) 

IMPORTANT
Allow yourself time to read and understand all the infor-
mation available on the BSA website and to register as a 
BSA e-filer.
Tax Year 2013 3
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K1_8825 
Worksheet

For an amount that flows from screen 4797 and is marked to go to Form 8825, Drake now 
breaks it out by property type in “Line 19 4797” column of worksheet K1_8825.

If the information is flowing from screen K1P (a partnership K-1) or screen K1F (a fidu-
ciary K-1), the amount appears in the K1_8825 worksheet in the “Line 20a Pass-thru” col-
umn.

179A 
Allocation 
Overrides

For information entered on screen 4562 (in the If sold section) or on screen 4797 on assets 
for which the taxpayer took 179 expense in the current or in prior years, you can override 
the calculated amounts that appear on the K1_179 worksheet on the new 179A screen 
(Figure 4).

The 179A screen 
is accessible on 
the General tab of 
the Data Entry 
Menu.

Entries made on the 179A screen do not affect the WK_179 worksheet.

Figure 4: Override 179 expense information on screen 179A.

The 179A screen allows you to choose among assets entered on the 4562 screen and on 
the 4797 screen, with links to both screens. A Screen Occurrence field allows you to 
choose which screen 4563 or 4797 the overrides refer to—in the event more than one of 
those screens occurs in the return.

Partners entered on screen K1, Partner Information, are listed in the Partner drop lists 
of the 179A screen. When a partner is selected, a percentage of the allocation being over-
ridden must be entered in the % column. (Note that the top two fields of the % column in 
Figure 4 are blue, indicating they are now required fields.)

SA screen A change to the SA screen allows you to enter a partner’s allocation based on a percentage 
only. You now need list only the partners that are getting an allocation, not every partner in 
the partnership, regardless of allocation.

Updating a Prior-Year Return in Drake

If you prepared the tax return in Drake last year, you will need to update the return for 
the current year. A prior-year return can be updated in three ways:

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2012 to 2013 (recommended) 

• When you open the return for the first time in the 2013 program and are prompted 
to update it
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• With all other returns in the program using Last Year Data > Update Clients 
2012 to 2013 (not recommended)

When you update a 1065 return that was marked as “final” the previous year, the pro-
gram informs you that the return was marked final before prompting you to proceed.

Header Information

Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1065.

Name and Address

Use screen 1 to complete the partnership name and address section of Form 1065. For 
state purposes only, if the partnership has an alternate address (such as a P.O. box), 
you can enter it in the Address Line 2 field at the bottom of screen 2. (Access screen 
2 from the States tab, or enter 2 in the selector field and press ENTER.) 

Tax Year

The software uses the calendar year as the default period for all partnership returns. 
No date entries are required on screen 1 for a December 31 tax year-end.

Fiscal and 
Calendar 

Years

If the partnership uses a fiscal year (where the year begins in the current calendar year 
and ends in the next), specify the beginning and ending dates in the If not a calendar 
year section of screen 1.

Short-Year 
Returns

A partnership may have a short-year return if changing accounting periods with IRS 
approval (Form 3115), or if this is its first or last year in business and the tax year is 
not a full year.

To indicate a short-year return, use the fiscal year date fields on screen 1 to indicate 
the beginning and ending dates for the current year. (These fields should not be used if 
the entity is filing a full calendar-year return.)

Boxes A through J

Enter most information for boxes A through J (top of Form 1065) on screen 1. Note 
that boxes D (Employer identification number), F (Total assets), and J (Schedule C 

NOTE
The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 52-
53–Week Year (Initial Return)” on page 41.

NOTES
For more information on short-year returns, see IRS Pub 4163.

The program may not correctly calculate depreciation, gains, or 
losses for a short-year return. Depreciation for a short-year return 
can be manually entered on screen 4562 or screens 6, 7, 8, and 9.
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and M-3 attached) are completed automatically based on information entered else-
where in the program. Other boxes are:

• Box A — Principal business activity

• Box B — Principal product or service

• Box C — Business code number (Press CTRL+SHIFT+S to search activity codes)

• Box E — Date business started

• Item G — Initial, final, or amended return; address or name change; technical ter-
mination

• Item H — Accounting method (Select Cash, Accrual, or Other; if Other, enter a 
description of the method used.)

• Item I — Number of K-1 forms attached (Completed automatically based on the 
number of K1 screens filled out. Use screen 1 to override this number.)

Income and Deductions

Enter income and deductions on the INC (Income) and DED (Deductions) screens. 
INC screen amounts flow to Form 1065, page 1, lines 1a to 7. (Also see “Other 
Income (Loss)” on page 8.) DED screen amounts flow to Form 1065, page 1, lines 9 
through 20. “Other income” and “Other deductions” data is shown on attached state-
ment worksheets in View mode of the return.

Schedule K 
Items

Commonly used fields from Schedule K (including fields for income, dividends, char-
itable contributions, and distributions) are provided at the bottom of the INC screen 
(Figure 5).

Figure 5: Schedule K fields at the bottom of the INC screen

NOTE
A technical termination occurs when there has been a sale or exchange 
of 50% or more of the interests in partnership capital and profits within a 
12-month period. On screen 1 in Drake, mark the Technical termina-
tion box and either Initial Return or Final Return as applicable.
6 Tax Year 2013



Drake Software User’s Manual Supplement: Partnerships Income and Deductions
 Amounts entered in these fields should not be re-entered on the K screens.

For information on the Schedule K items at the bottom of the INC screen, see “Sched-
ule K (Partners’ Distributive Share Items)” on page 20.

Gross Receipts

Enter gross receipts or sales and returns and allowances on the INC screen.

Cost of Goods Sold (Form 1125-A)

For cost of goods sold entries, complete screen A (Form 1125-A, Cost of Goods Sold).

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3, “Inventories.” Note that the inventory fields on screen L (Schedule L - 
Balance Sheet - Assets) are overrides; entries here override inventory data from 
screen A.

Line 5, Other 
Costs

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previ-
ous lines. In Drake, two fields on screen A are provided for line 5: one for other costs 
including depreciation and one for other costs excluding depreciation. (Figure 6).

Figure 6: Other costs and depreciation

In the Depreciation field, enter any depreciation that relates to the cost of goods sold 
(unless the amount is flowing from the 4562 Detail screen with COGS selected from 
the For drop list). Note that this field on screen A is an override field; an entry here 
overrides the calculations from the 4562 screen. Amounts entered in this field auto-
matically adjust the total depreciation that is carried to page 1 of Form 1065. For 
Other costs - excluding depreciation, use a CTRL+W worksheet. The depreciation 

NOTE
There is no “Charitable Contributions” line on page 1 of the 1065 
return. Charitable contributions belong instead on Schedule K. Enter 
charitable contributions on either the INC screen or screen K (but not 
both).

NOTE
The IRS does not require a detail (CTRL+W) worksheet for gross 
receipts; therefore, if you are using the trial balance import feature, do 
not include a detail worksheet for this line—or for any other line that 
does not require a detail worksheet.

NOTE
On screen A, items 9a through 9f are direct-entry fields and follow the 
format of IRS Form 1125-A. For more information on completing 
these fields, press F1 or consult the IRS instructions.
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amount is included on the statement for other costs and should not be included in the 
Other Costs worksheet.

Importing 
Trial Balance 

to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 46), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not in data entry. When the trial balance is imported, the COGS 
depreciation expense amount flows directly to the appropriate line of Form 1125-A 
and is calculated accordingly. For more on depreciation and trial balance import, see 
“Depreciation” on page 53.

Ordinary Income (Loss)

Ordinary income or loss from other partnerships, estates, and trusts (line 4 of Form 
1065) flows from either screen K1P (Schedule K-1 from another partnership) or 
screen K1F (Schedule K-1 from a fiduciary).

Net Farm Profit (Loss)

The partnership’s net farm profit or loss (line 5 of Form 1065) flows from information 
entered on screen F (Farm Income and Expense). Farm profit or loss from other 
partnerships, estates, or trusts appears on line 4 of the return. To enter this informa-
tion, from the INC screen, click the links to screen K1P or screen K1F on line 4. 
Enter the farm profit or loss from other partnerships, estates, or trusts on line 1 of 
screen K1P or line 6 of screen K1F.

For information on farming partnerships with a corporate partner, see Pub. 225, 
Farmer’s Tax Guide.

Net Gain (Loss)

The amount on line 6 (“Net gain (loss) from Form 4797, Part II, line 17”) of Form 
1065 flows from Form 4797. Amounts can also flow from screen 4562, but only if that 
screen shows assets sold and property type.)

Other Income (Loss)

Use the INC screen to enter amounts for the “Other income” line of the main form. 
Specific INC screen entries are displayed on attached statements in View mode of the 
return.

Amounts from the following screens also flow to line 7:

• Screen 6478 — Form 6478, Alcohol and Cellulosic Biofuel Fuels Credit

• Screen 8864 — Form 8864, Biodiesel and Renewable Diesel Fuels Credit

Additional fields on the INC screen include:

NOTE Line 16b on the DED screen, is an adjustment field for depreciation 
from Form 4562 not entered on screen A.
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• Interest income on receivables

• Recoveries of bad debts deducted in earlier years

• Section 481 adjustments

• State tax refund (cash basis)

• Taxable income from insurance proceeds

• Other income (itemize)

To enter additional sources of income not shown, create a CTRL+W worksheet for the 
Other income (itemize) field on the INC screen.

To enter other income (loss) from a partnership, estate, or trust, use the K1P or K1F 
screen (click the links on line 4 of the INC screen).

Compensation and Wages

Use line 9 of the DED screen to enter wages and salaries paid. Do not include guaran-
teed payments to partners or salaries or wages reported elsewhere in the return, such 
as the amounts included in COGS, elective contributions to a section 401(k) cash or 
deferred arrangement, or amounts contributed under a salary reduction SEP agree-
ment. (Drake automatically adjusts salary and wages for employment credits.)

Guaranteed Payments and Partner Health Insurance

Use the DED and K1 screens to report guaranteed payments and partner health insur-
ance. Note that guaranteed payments and health insurance are entered as separate 
amounts.

Guaranteed 
Payments

To report guaranteed payments to partners:

• Enter total guaranteed payments on the DED screen, line 10.

• Enter the guaranteed payments for each partner on line 4 of the Part III: K-1 
Direct Entries section of the partner’s K1 screen (Figure 7).

Figure 7: Part III section of screen K1

These entries should include any payments (or credits) to a partner for services ren-
dered. Include the use of any capital the partner provided if the payments (or credits) 
for that capital are not determined by the partnership’s income and can be allocated to 

NOTE
If the DED screen amounts do not equal the respective totals from the 
K1 screens, the program generates a “Guaranteed Payment Mis-
match” EF message. The return cannot be e-filed until this EF mes-
sage is cleared.
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a trade or business activity. These entries should not include any payments and credits 
that should be capitalized or any distributive shares of partnership profits.

Partner 
Health 

Insurance

To report partner health insurance:

• Enter the total deductible in the Partner’s health insurance field on the DED 
screen, line 10.

• Use screen K1, line 13M of the Part III: K-1 Direct Entries section, to allocate 
deductible payments for insurance that constitutes medical care for a partner or a 
partner’s spouse or dependents. (See Figure 7 on page 9.)

These amounts flow to Schedule K-1, box 13, and are included in the amount in box 4 
of the partner’s Schedule K-1. For information on the partnership’s contribution to a 
partner’s Health Savings Account (HSA), see Notice 2005-8, 2005-4 I.R.B. 368.

Repairs and Maintenance

Use the DED screen to enter the costs of repairs and maintenance. See Form 1065 
instructions for IRS requirements regarding costs that can be entered here.

Bad Debts

Use the DED screen to enter the total of all bad debts that became worthless during 
the 2013 tax year, but only if these debts related to a trade or business activity. Deduct-
ible non-business bad debts should be entered as short-term capital losses on screen 
8949.

Rents

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the partnership rented or leased a vehicle, enter the total annual rent or 
lease expense incurred in the trade or business activity of the partnership, and then 
complete Part V of the 4562 (screens 8 and 9).

Taxes and Licenses

Use the DED screen to enter tax and license payment data. Amounts entered here flow 
to the “Taxes and licenses” line of Form 1065. Data is also generated on the ATT_PTL 
worksheet in View mode of the return.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen are carried to the tax computation (ATT_TAX) worksheet. The state tax 

NOTE Cash-method partnerships cannot take a bad debt as a deduction 
unless the amount was previously included in income.

NOTE
Credit from Form 8846, Credit for Employer Social Security and Medi-
care Taxes Paid on Certain Employee Tips, automatically adjusts the 
amount of taxes and licenses on Form 1065.
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amount carried from the ES screen may differ depending on which method of 
accounting (cash or accrual) is used, and which tax type is selected.

Interest 

The “Interest” line of Form 1065 refers only to the interest incurred by the partnership 
in a trade or business activity that is not claimed elsewhere in the return.

Use the DED screen to enter interest expense amounts. Do not include interest 
expense on the following:

• Debt required to be allocated to the production of qualified property

• Debt used to buy rental property or debt used in a rental activity

• Debt used to purchase property held for investment

• Debt proceeds allocated to distributions made to partners during the tax year

Self-Charged 
Interest

Self-charged interest rules (see Form 1065 instructions) do not apply if a partnership 
elects under Reg. section 1.469-7(g) to avoid the application of them. If the partner-
ship is making this election, a statement must be attached to the return. To attach the 
statement:

1. Open the SCH screen.

2. In the Statement number field, type 03.

3. Assign a title such as “Self-Charged Interest” (no quotation marks needed).

4. Enter the following data, each on a separate line:

• Partnership name

• Street address (U.S. only)

• City (U.S. only)

• Two-letter state code (U.S. only)

• ZIP code (U.S. only)

• EIN

• “REGULATION SECTION 1.469-7(G) DECLARATION” (no quotation 
marks needed)

Do not mark the In-house note check box at the bottom of the SCH screen.

For more information on self-charged interest rules, see the “Self-Charged Interest” 
section of the Form 1065 instructions.

Depreciation

Use screen 4562 to enter depreciable assets for Form 1065, Form 1125-A, Schedule F, 
Form 8825, the RENT screen (rental other than real estate), and Section 754. (To 

NOTE Using the SCH screen for this statement will not prevent the return 
from being e-filed.
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associate a depreciable asset with an activity, make a selection from the For drop list 
at the top of the 4562 screen.)

Using the 
DED screen 

for Direct 
Entry

As explained further in the “Line 16, Depreciation” section following, the DED 
screen has two lines for direct entry of depreciation:

• Line 16a — Depreciation

• Line 16b — Depreciation claimed elsewhere on return

Any item entered in a depreciation field on the DED screen is added to the calcula-
tions from all 4562 screens. DED screen amounts are reflected on page 1 of Form 
1065 but are not shown on any generated Form 4562.

For more information on depreciation and the 4562 screen in Drake, see the Drake 
Software User’s Manual: Tax Year 2013.

Line 16, 
Depreciation

Line 16c of Form 1065 is reserved for depreciation that (1) is from Form 4562 and (2) 
is not claimed elsewhere. While the program pulls data from the 4562 screen for this 
line, it also provides field 16b specifically for depreciation that is claimed elsewhere.

Figure 8: Depreciation line 16 fields from DED screen

Both lines 16a and 16b on the DED screen are adjustment fields and add to or subtract 
from software calculations that are based on entries elsewhere in the program. Enter 
only the depreciation claimed on assets used in a trade or business activity:

• Line 16a — An entry here is added to the depreciation from the 4562 screens. The 
amount on line 16a is not reflected on Form 4562. See field-level help for further 
instructions and information on how this field ties in to the 4562.

• Line 16b — Drake recommends using screen A (rather than the DED screen) to 
enter depreciation claimed on Form 1125-A. An entry on screen A adjusts any 
entry on line 16b of the DED screen and is calculated into the total deductions on 
Form 1065. If there is an entry on line 16b but not screen A, only the line 16b 
amount is calculated into total deductions.

Section 754 Use screen 4562 to enter section 754 depreciation. To associate the depreciable asset 
with section 754, select 754 from the For drop list at the top of the screen.

For information on allocating Section 754 depreciation to specific partners, see “Sec-
tion 754 Allocations” on page 26.

IMPORTANT The depreciation fields on any screen should be used 
only if Form 4562 is not required.
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Section 179 Section 179 expense is not included on Form 4562, line 22, nor is it carried to line 16a 
of Form 1065. It is instead reflected on line 12 of Schedule K and distributed to each 
partner on Schedule K-1.

Reclassify to 
Amortization

To reclassify an asset from depreciation to amortization:

1. Open screen 4562 for the asset.

2. From the Method drop list, select AMT - Amortization.

3. Complete the applicable fields in the Amortization Information section, located 
near the bottom-left corner of screen 4562.

Depletion

Enter depletion amounts on the DED screen. If the corporation claims a deduction for 
timber depletion, complete and attach Form T, Forest Activities Schedules. (Attach as 
PDF to e-filed returns. See “The PDF Attachment Process” on page 43.) Do not 
deduct depletion for oil and gas properties.Depletion should be figured for each part-
ner. 

Retirement Plans

Use the DED screen to enter amounts for line 18, “Retirement plans, etc.” See the IRS 
instructions for guidance on what costs are acceptable for this line.

IRA for 
Employees

If the partnership contributes to an IRA for employees, include the contributions in 
salaries and wages on either the DED screen (“Salaries and wages” line) or screen A 
(“Cost of labor” line).

Payments to 
Partners

Do not use line 18 of the DED screen to deduct payments for partners to retirement or 
deferred compensation plans, IRAs, qualified plans, Simplified Employee Pension 
(SEP), or SIMPLE IRA plans. Report these amounts, which are deducted by the part-
ners on their own returns, on screen K, item 13d, code R. 

Employee Benefit Plans

Use the DED screen, line 19, to enter the partnership’s contributions to employee ben-
efits programs (such as insurance, health, and welfare programs) that are not part of a 
pension or profit-sharing plan included in line 18, “Retirement plans, etc.”

Amounts 
Paid for 

Medical Care

The line 19 amount should not include amounts paid for insurance that constitutes 
medical care for a partner, a partner’s spouse, or a partner’s dependents. For informa-
tion on entering amounts paid for medical care, see “Guaranteed Payments and Part-
ner Health Insurance” on page 9.

NOTE
The software reduces the expense based on the credit amount calcu-
lated from Form 8881, Credit for Small Employer Pension Plan 
Startup Costs.
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Pub. 541 IRS Pub. 541 states that premiums for health insurance paid by a partnership on behalf 
of a partner for services as a partner, are treated as guaranteed payments. The partner-
ship can deduct these payments as a business expense, and the partner must include 
them in gross income. The partnership cannot deduct the premiums, however, if the 
partnership accounts for insurance paid as a reduction in distributions for that partner, 
go to the K1 screen for the partner and mark the Health Insurance distribution 
reduction box.

A qualifying partner can deduct 100% of the health insurance as an adjustment to 
income. The partner cannot deduct the premiums for any calendar month, or part of a 
month, in which he or she is eligible to participate in any subsidized health plan main-
tained by the employer of the partner or the partner’s spouse.

Other Deductions

Enter all other deductions on the DED screen. Drake calculates these amounts and 
incorporates the total into the “Other deductions” line of Form 1065.

The following deductions, credits, adjustments, and exclusions also flow to the “Other 
deductions” line:

• Amortization from Form 4562, Depreciation and Amortization

• Credit adjustment from Form 6765, Credit for Increasing Research Activities

• Credit adjustment from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Filing an Extension

Calendar year returns are due on April 15, 2014. By filing Form 7004, a partnership 
can extend the deadline five months to September 15, 2014. Fiscal-year returns are 
due on the fifteenth day of the fourth month after the end of the fiscal year.

To file a 1065 extension, use one of the following options:

• Go to the 7004 screen in Drake (Other Forms tab of the Data Entry Menu) and 
select Generate an extension. Complete any other applicable fields on the screen.

• Go to the PRNT screen and select Prepare a Form 7004 extension.

Signing the Return

PIN signatures are required for e-filed returns. If e-filing a return, complete all fields 
on the PIN screen. A return cannot be e-filed if the PIN screen is not completed, 
including title and signature (name) of the general partner or LLC member manager.

If the return is prepared by a paid preparer, the preparer must complete the required 
information and sign the return in the space provided on the PIN screen. If it is pre-
pared by a partner or an employee of the partnership, select NONE in the Firm # and 
Preparer # drop lists on screen 1.
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To have the preparer’s signature displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO) are the same:

– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

– Complete the PIN screen for the return.

• If the return preparer and ERO are not the same, go to the PRNT screen and com-
plete the field labeled PIN for preparer’s alternative electronic signature. The 
PIN entered should match the one entered for the preparer in Setup > Pre-
parer(s). (For more information, press F1 in this field.)

Missing PIN 
Information

If you receive an EF message stating, “Missing Information on the PIN screen,” check 
the Title and Signature (name) fields the PIN screen for the partner signing the 
return. All applicable fields must be completed. (Phone number and e-mail address are 
not required.)

Form 
8879-PE

You must receive the completed and signed Form 8879-PE, IRS e-file Signature Autho-
rization for Form 1065, before the return is e-filed. This form must be kept in the tax 
office for three years from the return due date or IRS received date, whichever is later.

For information on using an electronic signature pad to digitally sign Form 8879-PE, see 
“Electronic Signatures” in Chapter 6, “Return Results,” of the Drake Software User’s 
Manual: Tax Year 2013.

Amending a Return

To file a 1065 return that has been amended:

1. Go to screen 1 in data entry and select Amended return in section G.

2. Make changes as applicable to forms and schedules.

3. Go to the EF screen and select Amended 1065 in the left-hand column.

4. Go to the SCH screen and complete the following fields:

• Statement number — Type 1B.

• Title — Enter a statement title of 28 or fewer characters.

• Explanation text box — Identify the amended items by line number and 
explain what was changed and why. 

NOTE
Setup > ERO must still be completed in Drake for e-file. For information 
on how to complete this setup window, see Drake Software User’s 
Manual: Tax Year 2013. See the IRS instructions for further details on 
signature requirements.

CAUTION

When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, 
you should archive the original to avoid losing previously sub-
mitted data. For more information on archiving returns, see 
“Archive Manager” in Chapter 6, “Return Results,” of the Drake 
Software User’s Manual: Tax Year 2013.
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If amending just the K-1s, go to each K1 screen, select Amended K1, and make 
needed changes.

TEFRA and Filing Eligibility

A partnership subject to the TEFRA (Tax Equity and Fiscal Responsibility Act of 
1982) audit rules cannot file an amended Form 1065 to correct a partnership item 
reported on a previously filed return, but according to these rules, the tax matters part-
ner (TMP) must file a Form 8082 on the partnership’s behalf and request the IRS treat 
the Form 8082 as a substituted return. A partnership qualifying as a small partnership 
(see Section 6231(a)(1)(B)) – with 10 or fewer partners at any one time during the 
year – is exempt from the TEFRA audit rules and can file an amended Form 1065 and 
corrected K-1s to partners.

Additional Information

This section covers Schedule B (Other Information), state-specific information, and 
some program overrides.

Schedule B

The program has three screens for entering data for Schedule B, Other Information:

• Screen B — For all but lines 3 and 4

• Screen B1 — For lines 3a and 3b

• Screen B4 — For lines 4a and 4b

From screen B, you can access screens B1 and B4 by clicking the applicable hyper-
links or by pressing PAGE DOWN (once for screen B1; twice for screen B4).

Ownership If any foreign or domestic entity (corporation, partnership, or trust) owns, directly or 
indirectly, an interest of 50% or more in profit, loss, or capital of the partnership, use 
the Line 3a section of screen B1 to enter the entity’s name, EIN, type, country of orga-
nization, and maximum percentage owned in profit, loss, or capital.

If an individual or estate owns, directly or indirectly, an interest of 50% or more in 
profit, loss, or capital of the partnership, use the Line 3b section of screen B1 to enter 
the individual or estate’s name, ID number, country of citizenship, and maximum per-
centage owned in profit, loss, or capital.

NOTE
When amending a 1065 return, all K-1s are amended, and the 
“Amended K-1” box on the return is marked, by default. To override this 
default, go to the PRNT screen and mark Do NOT check amended 
box on Sch. K-1.

NOTE
Which screens are required depends on the percentage owned. See 
Form 1065 instructions for calculating the maximum percentage 
owned.
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If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, 50% or more of the total voting power of all classes of stock entitled to vote 
of any foreign or domestic corporation, use the Line 4a section of screen B4 to enter 
the corporation’s name, EIN, country of incorporation, and percentage owned in vot-
ing stock.

If the partnership owned, directly, an interest of 20% or more, or owned, directly or 
indirectly, an interest of 50% or more in profit, loss, or capital in any foreign or 
domestic partnership or in the beneficial interest of a trust, use the Line 4b section of 
screen B4 to enter the entity’s name, EIN, type, country of organization, and maxi-
mum percentage owned in profit, loss, or capital.

Line 6 
Require-

ments

If question 6 on screen B is answered Yes, Schedules L, M-1, M-2, and Section L of 
Schedule K-1 are not required and therefore not printed. The four conditions that must 
be met in order to answer Yes to this question are:

1. The partnership’s total receipts for the tax year were less than $250,000.

2. The partnership’s total assets at the end of the tax year were less than $1,000,000.

3. Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return.

4. The partnership is not filing and is not required to file Schedule M-3.

Tax Matters 
Partner

The designated Tax Matters Partner (TMP) is the partner who is available to discuss 
tax information with the IRS. TMP information is printed at the bottom of page 3 of 
Form 1065. In Drake, the default Tax Matters Partner is partner #1 (the first partner 
entered on the K1 screen).

To designate a different partner, go to screen B and complete the Partner # field in the 
Tax Matters Partner section at the bottom of the screen. Note that most fields in this 
section are overrides; there is no need to enter additional information unless the part-
ner’s information differs from what is provided on that partner’s K1 screen.

If you don’t know the partner number, click K1 under the General tab of the Data 
Entry Menu. An Existing Forms List (see Figure 9) displays all partners with their 
respective numbers.

Figure 9: Schedule K-1, Partner Numbers

TIP You can force these schedules to be printed from the PRNT screen.
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State-specific Information

Resident 
State

The program automatically generates a return for the partnership’s resident state. Use 
screen 2 to enter company information as it should appear on the state return. (Access 
screen 2 from the States tab, or enter 2 in the selector field and press ENTER.)

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state) and state-specific dates and num-
bers for identification.

Contact 
Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2 (accessible from the States tab) for the alternative data for 
registered office, principal place of business, “Books in care of,” and general contact 
information for the partnership’s contact person.

Other States Data for other states must be entered in state data entry. To access state data entry, 
select the States tab from the return menu and select the desired states for state-spe-
cific screens (or type the two-letter state code in the selector field and press ENTER).

Multi-State 
Appor-

tionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment 
screen (accessible from the States tab or by entering APPT in the selector field and 
pressing ENTER). This screen (Figure 10 on page 19) provides one central location for 
entering all state apportionment information instead of having to open each needed 
state’s screen. 

In addition to making data input faster and easier, this feature provides two work-
sheets: a summary worksheet (SA-SUM~) that can be used for verifying input, and a 
reconciliation worksheet (SA-REC) that ties the total of the state amounts to the fed-
eral return figures. These worksheets are available in View mode.

The individual state apportionment screens will continue to be available in Drake14 
but will be used to override data entered on the APPT screen. No state apportionment-
related screens will be updated from Drake12 to Drake13.

NOTE The company information fields on screen 2 apply to the resident state 
only.
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Figure 10: APPT (Multi-State Apportionment) screen

APPT Screens The APPT screen is opened to the Sales tab. Links at the top of this screen take you to 
the Payroll, Property, and Additional Property information tabs for each state 
selected (Figure 10). These screens and their uses are listed in Table 1.

You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the 
reconciliation worksheet. Not every item appearing on the federal return may be sub-

NOTE
Mark the Zero Apportionment check box (Figure 10) to add a state but 
not include any apportionment data. This will include the state on the 
apportionment summary worksheet (SAC-SUM~), available through 
View mode.

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter salary, wage, commission, and labor amounts for 
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists

NOTE
The Ending amount entered on the Property and Addition Property 
screens in Drake13 will become the Beginning amount for property on 
the APPT screen when the client’s return is updated next year in 
Drake14.
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ject to multi-state apportionment. When you select OT, the data entered becomes a 
reconciling adjustment amount to aid in tying to the federal return. 

Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information will flow to that state’s return.

Other Information and Overrides

Use screen 1 to enter the following additional information:

Resident State — If the partnership has a mailing address in one state but does busi-
ness in another, use the Resident State drop list to select the state in which the part-
nership does business.

Drake Codes and Overrides — For information on miscellaneous codes, invoice 
numbers, and override fields, see the following sections of the Drake Software User’s 
Manual: Tax Year 2013:

– “Listing a Different Firm, Preparer, or ERO on a Return,” in Chapter 2, 
“Installation & Setup.”

– “Miscellaneous Codes,” in Chapter 5, “Return Preparation.”

Entity Name Control Override — Use this field only if your client has obtained a 
Name Control from the IRS.

Schedule K (Partners’ Distributive Share Items)

Use the K screens to enter data for Schedule K, Partners’ Distributive Share Items. 
For your convenience, the most common Schedule K items can be answered on the 
INC screen. If you enter these amounts there, do not re-enter them on the K screens. 

Two screens are used for Schedule K: 

• Screen 1 of 2 — Income, Deductions, Self-Employment, and Credits

• Screen 2 of 2 — Foreign Transactions, Alternative Minimum Tax (AMT) Items, 
and Other Information

Press PAGE DOWN and PAGE UP to navigate from one K screen to another.

NOTE
Note the screen K fields are primarily adjustment fields. Press F1 in a 
field to see what amounts are adjusted from elsewhere in the program, 
or see the adjustment and override worksheets, available in Appendix B 
and Appendix C of this document, and accessible from the FAQ screen.

NOTE The K screens should not be confused with the K1, K1G, or other 
related screens.
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Schedule K-1 for 1065 (Partner Information)

Use the K1 screen to enter data for Schedule K-1, Partner’s Share of Income, Credits, 
Deductions, etc.

In the Type of Partner section, line G, select the box to describe the partner as either 
a General or LLC member-manager or a Limited or other LLC member (default 
is General). On line H, select either Domestic partner or Foreign partner (default is 
Domestic).

From the line I1 drop list (Figure 11), choose the type of partner (not the type of part-
nership). If this box is left blank, the program uses the default selection of Individual.

If the partner is a retirement plan (IRS, SEP, Keogh, etc.) mark the I2 check box.

Figure 11: K-1 Partner Type

Ownership Changes

All ownership change information is entered on the OWN screen, which is accessible 
from the General tab of the Data Entry Menu. To use the OWN screen:

• At the top of the screen, enter the date the profit, loss, or capital interest in the 
partnership was exchanged by two or more partners. If profit, loss, and capital are 
all involved in a transaction, put the date in the Profit/Loss/Capital field only. 
The Loss and Capital fields are override fields, provided in case the loss or capi-
tal dates are different.

• In the Change in Percentages section, select the applicable partner from the drop 
list. (The drop list contains the names and ID numbers entered on each K1 
screen).

• Enter the percentage changes in profit, loss, or capital as positive amounts for 
increases and negative amounts for decreases. (See field-level help for more infor-
mation.)

• To enter additional ownership changes, press PAGE DOWN.

NOTE See FAQ item “P” in the program for more information on entering 
ownership-change information.
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Printed Data A Summary of Change in Ownership worksheet (WK_POWN) is generated listing all 
partners and the ownership percentages and changes.

IRS K-1 Codes

A code sheet can follow the printing of each Form 1065 K-1 to help the taxpayer inter-
pret the various codes used on Schedule K-1. To have this sheet printed with all K-1 
schedules, from the Home window of Drake, go to Setup > Options > Form & 
Schedule Options tab and mark the Print Page 2 of Schedule K-1 check box. The 
codes can also be printed on a return-by-return basis by marking the applicable box on 
the PRNT screen. The code sheet is also available from Tools > Blank Forms.

The Schedule K-1 may include asterisks with letter codes.

• An asterisk with a letter code indicates that multiple items have that code, or that a 
statement is required for the code.

• An asterisk at the bottom of a group indicates that there are more items than can fit 
in the space provided for that group and a statement is attached, or that the state-
ment is required (as in the case of “other” amounts).

Returns with Numerous Partners

For returns with a large number of partners, you have the option of deactivating calcu-
lation and printing of the K-1s while working on Form 1065. This option, which eases 
the process of reconciling the 1065, is available by going to the PRNT screen and 
marking the applicable box under K-1 Items to Suppress.

Partner Overrides

To override calculated amounts for the partners, you can either make changes on each 
K1 screen or go to the SA screen for partner special allocations and make all changes 
there. For more information, see “Special Allocations” on page 25.

Foreign Addresses

If the partner has a foreign address, enter the Province/ State, Country, and Postal 
Code information in the Foreign ONLY address line of the Partner Name and 
Address Information section (along with the street address and city in the Address 

NOTE
Code sheets are not displayed in View mode. If the 1065 K-1 is 
selected for printing, it is printed first, followed by the statements per-
taining to that 1065 K-1. These are followed by the code sheets.

NOTE After completing the K-1 entries for all partners, be sure to reactivate 
the calculation and printing of the K-1 from the PRNT screen.
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and City fields in section F.) Do not enter anything in the State or ZIP fields. Con-
versely, for a U.S. address, do not enter anything into the foreign address fields.

K-1 Export

Take the following steps to export a Schedule K-1 to a 1040 return.

1. Ensure that K-1 data is entered in the 1065 and that the 1040 return has been cre-
ated. (The K1P screen in the 1040 does not have to be created beforehand.)

2. In the 1065 return, go to View mode.

3. Click K1 Export in the View mode toolbar. A list of SSNs that cannot be 
exported appears, if applicable. Click Next.

4. The Export K1s dialog box (Figure 12) lists all client SSNs that can be exported. 
(To prevent an item in this list from being exported, remove the check mark to the 
left of it.)

Figure 12: SSNs ready to be exported

5. Click Export. The K-1 data will now appear on the partner’s 1040 tax return.

Supplemental Information

Two types of supplemental information can be added to Schedules K-1:

• Supplemental data for all K-1s in a return

• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s) enter the information in the 
Supplemental Information block of screen K1G.

To add supplemental information to an individual K-1, open a partner’s K1 screen and 
click the Supplemental Info link at the top of the screen. In the Supplemental Infor-
mation pane (Figure 13 on page 24), enter information pertinent to the partner.

NOTE
The Foreign ONLY fields are locked when a return is opened. Click in 
one of the fields to unlock them throughout the return. To relock the 
unused Foreign ONLY fields, close and then reopen the return.

NOTE
Basis information for individual partners should be entered in the 1040 
package in Drake; this information cannot be exported from the 1065 
package to a 1040 return. Such an import would override limitations 
and carryovers calculated in the 1040 program.
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Figure 13: In this example, the information entered on the K1P screen appears
on only Amelia Carter’s Schedule K-1.

Item M

If the answer to Schedule K-1, item M (“Did the partner contribute property with a 
built-in gain or loss?”), is “Yes” for all partners:

1. On the PRNT screen, select Yes in the Item M on Schedule K-1 section.

2. On screen K1G, select K1M - Built in Gain Loss Statement from the drop list, 
and type any supplemental information needed in the text box below.

If the answer is “Yes” for some partners but not others, use the individual partners’ 
Item M screens to report the supplemental information. The Item M screen is 
accessed by clicking the 8805/Item M tab at the top of any partner’s K1 screen. The 
supplemental information should list each property the partner contributed, the date 
the property was contributed, and the amount of the property’s built-in gain or loss.

Partner’s Adjusted Basis Worksheet

Use the Partner’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a part-
ner’s new basis after increases or decreases are made to basis during the current year. 
A partner’s adjusted (outside) basis refers to the partner’s investment in a partnership. 
The basis is determined without considering any amount shown in the partnership 
books as capital, equity, or similar account. When a partner disposes of an interest in a 
partnership, the difference between the sale price and the adjusted basis is the taxable 
gain or loss.

NOTE
Basis information for individual partners should be entered in the 1040 
package in Drake; this information cannot be exported from the 1065 
package to a 1040 return. Such an import would override limitations 
and carryovers calculated in the 1040 program.
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The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 
screen for a partner. (Access the K1 screen from the Data Entry Menu.)

Increases 
and 

Decreases 
to Basis

Increases to basis can include cash contributed, taxable income of partnership (includ-
ing capital gains), tax-exempt income of partnership, and partner’s adjusted basis of 
property transferred to a partnership.

Decreases to basis can include distributions of cash or property to partners, separately 
stated losses and deductions, nondeductible business expenses, and credit adjust-
ments.

Annual 
Update of 

Partner 
Information

When the program is updated to the next tax year, the end-of-year basis and liability 
amounts are automatically updated to the beginning of the year. Any loss or deduction 
carryover is updated to the beginning of the year and its character (ordinary loss, sec-
tion 179 expense, charitable contributions, etc.) maintained.

Special Allocations

Use the SA screen (see Figure 14 on page 27) for partner special allocations to allo-
cate liability, capital, and K-1 Part III (Income, Deductions, Credits, and Other Items) 
amounts to individual partners without having to enter the information into each K-1 
separately. Amounts can be entered as dollar amounts or percentages. Calculations 
from the SA screen flow to the appropriate fields of each individual K-1.

To enter partner special allocations:

1. Open the SA screen, accessible from the General tab of the Data Entry Menu.

2. Make a selection from the Allocation type drop list at the top of the screen

3. Select a partner from the Partner’s ID Number and Name drop list and enter the 
allocation figure in the Allocation Percentage or Amount field to the right of it.

Repeat these steps for all involved partners. To enter data for more than one allocation 
type, press PAGE DOWN to access a new SA screen.

NOTE The Basis Worksheet is printed only when the option is selected on the 
PRNT screen.

NOTE If a K1 screen is marked as final, none of the related screens for that 
partner is updated for the next year.

NEW FOR 

 2013

A change to the SA screen allows you to enter a partner’s alloca-
tion based on a percentage only. You now need list only the part-
ners that are getting an allocation, not every partner in the 
partnership, regardless of allocation.

See “Grid Data Entry” on page 26 for details of an easy way to 
enter amounts on the K-1 screens.
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There is no limit to the number of partners than can be entered. If there are more than 
10 partners for whom you must enter special allocations, or an allocation type that 
must be allocated to more than 10 partners, press PAGE DOWN for a new SA screen.

Grid Data 
Entry

If you have your program set up to take advantage of grid data entry, you can easily 
enter amounts in many of the most-often used lines of a Schedule K-1. This method is 
particularly useful for partnerships with a lot of partners.

First, initiate grid data entry:

1. Return to the Drake Home window.

2. From the menu bar, select Setup > Options open the Data Entry tab.

3. At the bottom of the left-hand column, select Use grid data entry format on 
available screens. Click OK.

Now, open a return, and from the K-1 Information section of the General tab, select 
K1 Schedule K-1 Partner Information to open the data-entry grid. To make entries 
in the grid:

1. Select a partner and click in one of the fields where you wish to enter an amount.

2. Type in an amount for that partner for that column.

3. Scroll across to see more columns and make any entries needed.

4. Press the DOWN ARROW to make entries for other partners.

5. To open a partner’s K1 screen and make any other entries, click Item Detail.

6. To return to the grid, close the partner’s K1 screen.

You can arrange the grid by ID number, by partner’s name, or by the amounts in the 
columns of the grid by clicking the column headers. 

Section 754 
Allocations

To allocate section 754 depreciation among specific partners:

1. Indicate an amount of section 754 depreciation using either (but not both) of the 
following methods:

• On screen 4562, select 754 from the For drop list.

• On screen K, line 13d, code W (“Section 754 depreciation”), enter the amount 
of section 754 depreciation to be reported to the partners.

2. Allocate the amounts. You can do this using either the K1 screen or the SA screen, 
but not both.

• K1 screen — On line 13, “Other deductions,” select code W and allocate the 
amount of section 754 depreciation for that partner. (For any partner not 
receiving an amount for section 754 depreciation, the code and a zero (0) must 
still be entered. A statement will still be produced for that partner.)

• SA screen — Select item 148 (Line 13 - W Other deductions) from the 
Allocation type drop list (Figure 14 on page 27).
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Figure 14: Entering partner allocation information on the SA screen

Domestic Production Activities Deduction

A partnership does not take the deduction for Form 8903, Domestic Production Activ-
ities Deduction. Instead, the amounts pass through to the partners to report on their 
individual returns. The partners use the information to calculate their eligibility for the 
deduction. (For more information, see the IRS Form 8903 instructions.)

If Print K1_8903 worksheet for each partner is not selected on screen 8903, the 
amounts flow to line 12 of Schedule K-1 (codes Q and R). If this box is selected, the 
information flows to the K-1_8903, which is referenced on a statement. Code P is 
printed on line 12 of Schedule K-1 to indicate domestic production activities informa-
tion.

K-1 Cover Letters

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.

Producing 
Letters for 

All Returns

To have the K-1 cover letters produced automatically with all applicable returns, go to 
Setup > Options > Optional Documents tab and mark the box labeled Include K-1 
letter with returns. The signature on the return can be produced in one of three ways:

NOTES

Line 11 (“Income limitation”) of the Form 8903 is not applicable for 
the partnership because the income limitation is calculated at the 
partner level.

“Form W-2 wages” (on the 8903 screen) refers to the partnership’s 
W-2 wages paid that are applicable to the Domestic Production 
Activities Deduction.

TIP

To prevent the partnership’s name and address from being generated 
in the header of the letter, go to the K1L screen (accessible from the 
Miscellaneous tab) and mark the Do not print entity information 
box. (You must first select the Use letterhead on letters box at Setup 
> Letters > Setup > Letterheads, Margins and Borders for any entity 
info to appear as a header.)
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• By completing the Tax Matters Partner fields at the bottom of on screen B 
(Schedule B)

• By completing the partner information on the PIN screen (an entry here overrides 
the Tax Matters Partner information on screen B)

• By going to the K1L screen and entering the name and title of person signing the 
letter (an entry here overrides both screen B and the PIN screen)

Producing 
Letters for a 

Single 
Return

If no default has been set in Setup > Options > Optional Documents tab to produce 
K-1 cover letters with all returns, you can enter the name and title of the person who 
will be signing the K-1 cover letters by opening the return, opening screen K1L, and 
entering the name and title at the bottom on the screen.

Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office 
needs and style.

To edit the text of the K-1 letter:

1. From the Home window, select Setup > Letters. The Client Communications 
Editor is displayed.

2. Select Open > Partnership > Partnership K-1 Cover to view the template of the 
partnership K-1 letter.

3. Make any desired changes to the template.

4. Click Save.

Schedule L (Balance Sheets Per Books)

Schedule L is not required if:

• The partnership’s total receipts for the tax year were less than $250,000

• The partnership’s total assets at the end of the tax year were less than $1 million

• Schedules K-1 are filed with the return and furnished to the partners on or before 
the due date (including extensions) for the partnership return

• The partnership is not filing, and is not required to file, Schedule M-3

NOTE If nothing is entered in any of the fields referenced above, the program 
will use the name of the partner on the first K-1 for the signature.

TIP
Review the following sections of the Drake Software User’s Manual: 
Tax Year 2013 before making changes to letter templates:

- “Introduction to Letters in Drake” in Chapter 2, Installation & Setup

- The “Letter Keywords” section of Appendix B, Keywords

NOTE
For an amended return, the K-1 letter automatically refers to the 
amended K-1. To edit the letter for an amended K-1, select Open > 
Partnership > Partnership K1 Amended and follow steps 3 and 4 of 
the previous procedure.
28 Tax Year 2013



Drake Software User’s Manual Supplement: Partnerships Schedule L (Balance Sheets Per Books)
If the partnership meets all four of these conditions, go to screen B and select Yes for 
line 6. Because Schedules L, M-1, M-2, and Item L of Schedule K-1 are not required, 
they will not be generated with the return. (To force these items to be printed, go to the 
PRNT screen and, in the Items to Print section, select Force Schedules L, M-1, M-
2, & K-1 Section L.)

If any of the four conditions are not met, select No for line 6. Schedules L, M-1, M-2, 
and Item L of Schedule K-1 are required and will be printed with the return.

Flow of Information

Many entries made elsewhere on the return (for example, inventory information on 
screen A) flow to the generated Schedule L. Depreciable asset information, intangible 
assets, and amortization from the 4562 screen also flow to Schedule L. 

Direct entries on screen L include beginning- and end-of-year Cash, Trade notes and 
accounts received, bad debts, U.S. government securities, tax exempt securities, 
loans to partners, mortgage/real estate loans, depletable assets, and accumulated 
depletion. Schedule L data would come from the partnerships’ income statement, bal-
ance sheet, and equity and capital accounts.

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in 
Drake. In other words, if you use this screen for all applicable lines on Schedule L, 
you do not need to make any entries on the L screen.

To create a statement for a line, select the line from the drop list (see Figure 15 on 
page 30) and enter descriptions and their corresponding amounts. Once the informa-
tion is entered, or if additional descriptions are required for the line, press PAGE 
DOWN to access a new screen.

Statements The total amounts entered on the SCH2 screen do not appear on the L screen in the 
program. They are, however, printed on the return where applicable, with references 
to the corresponding statements.

The type of statement produced by the program depends on the selected line and the 
IRS requirements. If a line is required, a statement labeled “STATEMENT” is pro-
duced and is e-filed with the return. If a line is not required, a statement sheet 
(“STMT”) is produced and is not e-filed with the return.

Note that an e-fileable “STATEMENT” is referenced in the return (Figure 15 on 
page 30).

NOTES

All line selections are carried to the next-year program when the 
returns are updated. Screen descriptions are updated, with the 
year-end amounts carried to the beginning-of-year column.

To access the SCH2 screen from the L screen, click the SCH2 
Screen hyperlinks on lines 6, 8, 13, 17, or 20 (or click inside a field 
and press CTRL+2).
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Figure 15: Data entered as “Other Current Assets” from the drop list on screen SCH2 will be 
attached as an e-fileable statement and referenced on the applicable line of the return.

SCH2 and 
Trial Balance

Typically, one or more SCH2 detail screens are needed for Schedule L items. If using 
Drake’s trial balance import feature, be aware that SCH2 data cannot be entered 
directly into the trial balance worksheet, as they cannot be imported into the data 
entry. SCH2 detail screens must be created apart from the trial balance worksheet.

When the return is produced, Schedule L reflects the amounts imported from the trial 
balance worksheets (where direct entry was allowed). For more information, see 
“SCH2 Detail” on page 53.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the capital account on Schedule L by the difference 
between the total assets and the total liabilities and capital before the adjustment.

(Example: If Assets = $1,000 and Liabilities and Capital = $900, the program 
increases the partners’ capital accounts by $100.)

To deactivate this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

Schedules M-1, M-3 (Reconciliation of Income)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Schedule M-3 is required if the balance sheet’s total assets at 
the end of the year equal or exceed $10 million.
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Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with the taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable, as 
described in Table 2:

Depreciation 
and 

Amortization 
Adjustments

The program may make an adjustment for book-to-tax depreciation differences. The 
calculation is done with the following steps. (This procedure refers to “depreciation” 
throughout, but it applies for either depreciation or amortization.)

1. The amount reported on the Schedule L “Beginning of Year” accumulated depre-
ciation (line 9b, column a) (line 10b is “accumulated depletion”), is subtracted 
from the “End of Year” accumulated depreciation (line 9b, column c). This is the 
“book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is the depreciation amount reported on the return, 
including any section 179 amounts).

3. The differences between the “book” and “tax” depreciation amounts are carried to 
the appropriate form and line.

• If the “book” depreciation amount is greater than the “tax” depreciation 
amount, the difference is carried to either:

– Schedule M-1, line 4a

– Schedule M-3, Part III, line 25, as a negative amount

– Form 8916-A, line 2(L), as a negative amount for assets selected on the 
4562 detail screen for COGS

• If the “tax” depreciation amount is greater than the “book” depreciation 
amount, the difference is carried to either:

– Schedule M-1, line 7a

– Schedule M-3, Part III, line 25, as a positive amount

Table 2: Examples of Book-to-tax Difference for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not 
during the same tax year

- Depreciation
- Gains or losses on the sale of 

depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment
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– Form 8916-A, line 2(L), as a positive amount for assets selected on the 
4562 detail screen for COGS

Schedule M-3

The Schedule M-3 section of the Data Entry Menu includes direct access to the var-
ious M3 screens (Figure 16).

Figure 16: Data Entry Menu for M and M-3 schedules

If a domestic partnership reports on Form 1065, Schedule L, that its total assets at the 
end of its tax year equal or exceed $10 million (or that its gross receipts equal or 
exceed $250,000), it must complete and file Schedule M-3 instead of Schedule M-1.

Parts II and III of Schedule M-3 reconcile financial statement net income (loss) for the 
tax return (per Schedule M-3, Part I, line 11) to net income (loss) on Form 1065, page 
5, “Analysis of Net Income (Loss),” line 1.

If the partnership is required to file (or voluntarily files) Schedule M-3, the partnership 
must file Form 1065 and all attachments and schedules, including Schedule M-3. 
Additional information could be required on the 8916 and SCH3 screens.

The SCH3 
Screen

The SCH3 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule M-3 (or Form 8916-A). This screen can be used in place of the 
actual M3 screen in Drake. In other words, if you use this screen for all applicable 
lines on Schedule M-3 or Form 8916-A, you do not need to make any entries on the 
M3 and 8916 screens. The total amounts entered on the SCH3 screen do not show up 
on the actual M3 and 8916 screens in the program. They are, however, printed on the 
return as applicable, with references to the corresponding statements.

To create a statement for a line, select the desired line from the drop list, then enter 
descriptions and their corresponding amounts. Once the information is entered, or if 

NOTES

The program calculates total assets based on IRS requirements. 
For more information, see the Adjusted Total Assets Worksheet 
produced with the return.

Some calculated amounts flow automatically to M-3; some data 
must be manually entered on the M3 screen. Review all amounts 
on the M-3.
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additional descriptions are required for the line, press PAGE DOWN to access a new 
screen (make the same selection from the Select line number drop list.)

As with the SCH2 screen, the type of statement produced by the program depends on 
the line selected on the SCH3 screen and the IRS requirements. See “The SCH2 
Screen” on page 29 for more information on how to use the SCH3 screen.

Schedule M-2 (Analysis of Partners’ Capital Accounts)

Schedule M-2 is used to show what caused changes during the year in the partners’ 
capital accounts. The amounts on Schedule M-2 should equal the total amounts 
reported in item L of all the partners’ Schedule K-1s.

Drake carries amounts entered in item L (Analysis of Capital Account) on the part-
ners’ K1 screen to the Form 1065, Schedule M-2, line 1, “Balance at beginning of 
year.”

Rental Activities

Income and expenses for rental real estate properties appear on Form 8825, Rental 
Real Estate Income and Expenses of a Partnership or an S Corporation. To make 
entries in Drake, use the 8825 screen.

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 
reports each property’s information on a separate column of Form 8825. Data from all 
8825 screens are transmitted to the IRS when the return is e-filed.

Line 14, Depreciation

If the program is calculating depreciation (entered on the 4562 screen) for the property 
listed on the 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered only if it is figured outside of the Drake program, and then the net 
results should be entered on screen 8825. The amount entered on line 14 is added to 
the depreciation calculated from the 4562 screens.

NOTE All line selections are carried to the next-year program when the 
returns are updated. 

NOTE Special steps are required if using the trial balance worksheet for mul-
tiple rentals. See “Rental Expenses” on page 54 for more information.

NOTE For assets placed in service during the year, Form 4562 is required.
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Carrying 
Information 

to Form 8825

To indicate that the information should be carried to Form 8825, select 8825 from the 
For drop list on screen 4562 (Figure 17). If there are multiple 8825 screens, use the 
Multi-form code box. For information on using the Multi-form code box, see the 
Drake Software User’s Manual: Tax Year 2013.

Figure 17: In this example, the program carries the 4562 information
to the third 8825 screen created.

Any depreciation information entered on the 4562 screen is carried to the correct 
Form 8825, based on the form and multi-form code selections at the top of the 4562 
detail screens.

Line 15, Other Expenses (list)

For rental properties with an “other” expense (line 15), enter the amount of guaranteed 
payments or meals and entertainment in the appropriate fields (see Figure 18). For 
rental properties with more than one “other” expense, double-click the text box on the 
Additional other expenses line to open a Detail Worksheet. Enter a description in 
the Description field and an amount in the Amount field. (The shaded field indicates 
a worksheet was entered.)

Figure 18: Screen 8825, fields for line 15, “Other” expenses

Totals from the worksheet flow to Form 8825, and a statement from each property is 
printed with the return and is transmitted to the IRS when the return in transmitted.

IMPORTANT

When selecting a multi-form code, note that the code 
should refer to an 8825 screen—not the 8825 form. For 
example, data from the third 8825 screen will be gener-
ated on the first Form 8825. To associate an asset with 
that information, you would enter a “3” for the screen (not 
a “1” for the form) in the Multi-form code box. For more 
information on Form 8825, see “Viewing Rental Activity 
Information” on page 35.

NOTE
The check box on line 15 indicates health insurance premiums that 
are part of the guaranteed payments made to the partners are 
claimed as an expense for rental real estate.
34 Tax Year 2013



Drake Software User’s Manual Supplement: Partnerships Rental Activities
Enter rental income the partnership receives on a K-1 on the K1P screen. This amount 
is carried to Form 8825, lines 20a and 20b. No entry is required on the 8825 screen.

Viewing Rental Activity Information

Rental activity data is viewed on the 8825 forms and accompanying statements.

• 8825 Forms — Form 8825 can contain information for up to eight rental activi-
ties. If more than four rental activities are entered, a second page of Form 8825 is 
generated. If more than eight rental activities are entered, a second Form 8825 is 
created.

Figure 19: Multiple 8825 pages are created if more than eight rental activities

• 8825 Statements – Statements are titled STM 8X, where X equals A to H for the 
first Form 8825. (For example, the statements for the first and second 8825 
screens would be labeled STM 8A and STM 8B, respectively.) As shown in 
Figure 20, there are also 8825 attachments (8825_ATT) for other reporting infor-
mation. (The statements are generated only if information is entered on the “Addi-
tional other expense” line of screen 8825.)

Figure 20: 8825 statements and attachments
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Self-Employment Income

If Mark this box to include in self-employment income is selected at the top of the 
8825 screen, the amounts from the 8825 screen are included in the calculation for line 
14a of Schedule K and flow to each K-1. Self-employment calculations are shown on 
the WK_SE worksheet generated with the return.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. Drake 2013 carries 
the required adjustments to the appropriate line of the return and to the M-1.

Manually reducing the expenses/deductions or increasing the income for these credits 
causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its:

• Form 6478, Alcoholic and Cellulosic Biofuel Fuels Credit

• Form 8864, Biodiesel and Renewable Diesel Fuels Credit

• Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts 
for the following credits:

• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

• Form 8820, Orphan Drug Credit

• Form 8845, Indian Employment Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8844, Empowerment Zone and Renewal Community Credit

• Form 8912, Credit to Holders of Tax Credit Bonds

• Form 8941, Credit for Small Employer Health Insurance Premiums

Elections

The ability to make certain tax elections is included in the Partnership package. Elec-
tions are selected from the Return Elections section of the ELEC screen (Figure 21 
on page 37).

NOTE No adjustment is carried to the M-3 automatically for 2013.
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Figure 21: Return Elections portion of ELEC screen

Making an Election in Drake

To indicate that the partnership is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu).

2. Make a selection from the Election drop list. (See Figure 22)

Figure 22: Election drop list

3. Complete all other fields as applicable. Press F1 in any field to learn if that field is 
required for your selection and the type of information that may be needed. For 
example, the help text for the Date or year-ending field (Figure 23 on page 38) 
shows that the field is required only for election options 08, 11, 13, 15, and 21, 
and it explains what, specifically, should be entered for each of these elections.
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Figure 23: Help text for Date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “STM ELXX,” where “XX” is the number of the 
election. For example, election 01 (General Election Statement) is generated as STM 
EL01.

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date, amount, or location.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

Making Changes on the Fly

Use the PRNT screen to override program defaults.

Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the PRNT screen and 
select the desired options. Many “on the fly” changes override options that are set up 
globally in Setup. <That’s a sentence fragment.

1065 Items The following Form 1065 items can be forced or suppressed from the PRNT screen.

• Force Schedules L, M-1, M-2 & K-1 Section L — Schedules L, M-1, M-2, and 
K-1 Section L are not printed unless required. To have these schedules printed 
with the return, select this box.

NOTE
If the election option you selected is not listed in the help text for a 
field, then that field should be left blank. For example, if you chose 
election 01 (General Election Statement), you would not need to 
enter anything into the Date or year-ending field (help text in 
Figure 23).
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• Print Form 8893, Election of Partnership Level Tax Treatment — Select this 
box to generate Form 8893 with the return. (There is no equivalent 8893 screen, 
but the form is produced. All information for the form is available from other data 
entry screens.)

• Print Form 4562 — Form 4562, Depreciation and Amortization is not generated 
unless applicable. Select this box to force the Form 4562 to be printed. (To force 
Form 4562 for all returns, go to Setup > Options > Form & Schedule Options, 
and clear the check box labeled Print Form 4562 only when required.)

• Print next-year depreciation listing— Select this box to print the next year’s 
depreciation schedule if the option is not already selected in Setup > Options > 
Form & Schedule Options.

• Print inactive return — By default, the program does not generate a return for a 
partnership that is inactive. Select this option to override the default for an inac-
tive return.

• PIN — To have the preparer’s signature appear on the printed copy of return, 
enter the preparer’s PIN here.

• Items to Suppress — Select the boxes corresponding to any worksheets, forms, 
or functions to be suppressed in the return:

– ATT_PTL (Taxes and Licenses Attachment) or the ATT_PSW reference on 
page 1

– Estimated Tax Payment Summary

– Printing of WK_M2, Partners’ Capital Reconciliation Worksheet

K-1 Items Described below are Schedule K-1 items that can be forced or suppressed from the 
PRNT screen:

• Select to print:

– The partner’s adjusted basis worksheet

– Page 2 of Schedule K-1 (codes)

• Select to Suppress:

– Schedule K-1, K-1 letter, K-1_ATT, or WK_PBAS

– Schedule K/K-1 Comparison Worksheet or the Capital Account Reconcilia-
tion

– K1_179 for each partner

– Marking of “Amended K-1” box on printed Schedule K-1

• Item L on Schedule K-1 (Partner’s capital account analysis) — Select the box 
(Figure 24) to indicate the calculation method used for the partners’ capital 
account. (If Other, indicate the method in the text box; this item is required.)

Figure 24: Items L and M of PRNT screen
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• Item M on Schedule K-1 — Select this box to answer item M of Schedule K-1 
for all partners. To answer it for each individual partner, go to the partners’ K1 
screens. See “Item M” on page 24 for more information.

See field help (F1) for more information on the options available.

Overriding Other Setup Options

Filing instructions (federal and state) and envelope coversheets (partnership, IRS, 
state, city, and K-1s to partners) can be either forced or suppressed from the PRNT 
screen to override the global setting in Setup.

In addition, you can select Turn off autobalance to disable the autobalance feature 
(see “Autobalance” on page 30) and select Prepare a Form 7004 extension if send-
ing an extension application. (See “Filing an Extension” on page 14.)

The following program defaults can also be overridden from the PRNT screen:

• Date to print on return

• Due date to print on letter and filing instructions (see note below)

• Amount on Form 1065, page 1, item F (“Total assets”)

• IRS Service Center

Guide to Overrides and Adjustments

An Adjustment Worksheet and an Override Worksheet, available through the FAQs, 
allow preparers to see what data or calculations are being affected when an entry is 
made in an override or adjustment field. These worksheets can provide a better under-
standing of how overrides and adjustments work in the software.

To access the worksheets, click the Screen Help button at the top of the FAQ screen, 
then click the link for the desired worksheet and wait for the worksheet to be dis-
played as a PDF file. An Internet connection and Adobe Reader are required in order

to view the worksheets.

Much of the information contained in the worksheets is also available from the field-
level helps within the program. To access a field-level help, click inside a field and 
press F1, or right-click in a field and select Help > Help for this Field.

Electronic Filing

Some partnerships with more than 100 partners are required to e-file Form 1065, 
Schedules K-1, and other related forms and schedules. For other partnerships, e-file is 
optional.

NOTE
A default due date for filing is printed on all letters and filing instruc-
tions generated with a return. You can override the default by enter-
ing an alternate due date in the Due date to print on letter and 
filing inst field.
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Steps for e-filing Form 1065 are the same as for e-filing Form 1040, with the excep-
tion of Bankruptcy return, which must be paper-filed. For detailed instructions on
e-filing returns in Drake, see Drake Software User’s Manual: Tax Year 2013.

Additional Return Types

The following special types of business returns can be e-filed using Drake:

• Returns for entities using a 52-53–week year

• Short-year returns

• Inactive returns

For information on how to indicate a short-year return in Drake, see “Short-Year 
Returns” on page 5.

Electing a 
52-53–Week 
Year (Initial 

Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the ELEC screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year beginning 
and Fiscal year ending dates. Use MMDDYYYY format, as shown in the exam-
ple in Figure 25.

2. Mark the 52-53-week tax year box.

Figure 25: In this example, the fiscal year begins 01/01/13 and ends 12/30/13
(the Wednesday closest to the end of December), giving the entity a 53-week year for 2013.

3. Click the ELEC Screen link to open the Election Options screen (Figure 26).

Figure 26: Elections for 52-53–week tax years

4. For line 1, select the month in which the 52-53–week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.
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5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ending field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

Inactive 
Returns

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.

2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, to the right of lines 1a and 1b). Zeros are dis-
played where required by the IRS in order for amounts to be properly included in the 
e-file data.

Common Error Codes

If one or more of the following IRS error reject codes is generated when you e-file a 
1065 return, you must contact the IRS for further information.The e-file help desk 
number is (866) 255-0654.

• Reject Code R0000-922-01 — Filer’s EIN and name control in the return header 
must match data in the E-File Database, unless “Name Control” or “Name of 
address change” check box is checked, if applicable.

• Reject Code R0000-900-01 — The return type indicated in the return header 
must match the return type established with the IRS for the EIN.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-

NOTE
Once a 52-53–week year is selected, the entity must use that 
accounting period every year. To change accounting periods, the 
entity must submit to the IRS Form 3115, Application for Change in 
Accounting Method.

NOTE All EF messages must be cleared in order to e-file an inactive return.

NOTE
If a reject associated with the return’s “Name Control” occurs, some of 
your questions can be answered on the IRS’s website. For details, go to 
www.irs.gov/Tax-Professionals/e-File-Providers-&-Partners/Using-the-
Correct-Name-Control-in-e-filing-Partnership-Tax-Returns
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port or explain an entry in the return. In either case, a document must be printed, 
scanned into the computer, and attached to the return in order to be e-filed with the 
return.

You can attach PDF files to federal partnership (1065) returns for e-file. The PDF 
Attachments screen is accessible from the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF document to be attached

2. Informing the program that a PDF document will be sent with the return

3. Attaching the PDF document for e-filing

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Documents 

in Drake

To indicate in the software that a PDF document will be sent with the return:

1. Open the return in Drake. From the Data Entry Menu, click PDF Attachments, 
accessible from the Electronic Filing section of the General tab (or type PDF in 
the selector field and press ENTER). (See Figure 27)

Figure 27: Select PDF Attachments, or type PDF into the selector field and press ENTER

TIP It’s a good idea to use the DDM scanning feature for this step.

NOTE
Many types of documents (for instance, documents created in Microsoft 
Word) can be printed or “saved” as PDF documents if you have a PDF 
printer (such as Adobe Reader) installed.
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2. Fill out the columns on the PDF Attachments screen. See Table 3 for examples.

3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF document is attached, the program generates an 
EF message regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Documents in Drake,” previously), there will be two 
PDF–related items in the View/Print window:

• An EF Message alert (item #1 in Figure 28)

• An Attach PDF button on the toolbar (item #2 in Figure 28)

Figure 28: The MESSAGES file (1) and the Attach PDF button (2)

2. Click the MESSAGES file to view EF messages, including information on how to 
attach the required documents to the return.

3. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF Attachments window in data entry. A red X 
means the document has not yet been attached; a green check mark indicates an 
attached document (Figure 28).

Table 3: PDF Attachment Window Columns

Name of Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 1065

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Figure 29: The EF PDF Attachments window

4. Click the row of a document to attach.

5. Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return (and show a green check mark), recalculate the return. If all EF mes-
sages have been resolved, the return is ready to be e-filed.

Printing Generated Documents

In some instances, Drake generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. For example, if Form 
3115, Application for Change in Accounting Method, is present in a partnership 
return, message 1515 is generated when the return is calculated.

Figure 30: EF message 1515

As shown in Figure 30, the EF message states that attachments are required. You 
would need to obtain or complete the statements, scan them into the computer, save 
them as PDF documents, and attach them to the return.
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Importing Trial Balance Information

Drake trial balance import feature allows data to be imported into a 1065 return from a 
trial balance worksheet. The trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in 
Drake 2008 or later. If you haven’t already, create a client file in Drake or update an 
existing client file from the prior year. Like several other functions of the tax software, 
this feature requires Microsoft Excel (version 2000 or later).

If you haven’t already, create a client file in Drake 2013 or update an existing client 
file from the prior year.

In addition, take these actions to ensure the trial balance import works properly:

• Enable Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro security is set to “medium.” To do so, go to Tools > Options in Excel and 
select the Security tab. Click Macro Security and select Medium, then click 
OK.

• Disable Autobalance — When autobalance is disabled, the program is prevented 
from automatically adjusting the year-end retained earnings or capital amounts, 
thus allowing you to see any discrepancies in the balance sheet. To disable auto-
balance, go to the PRNT screen and select Turn off autobalance (Figure 31).

Figure 31: Disable autobalance in Other Return Options section of PRNT screen

NOTE A flow chart of the trial balance importing process is available as 
Appendix A, Trial Balance Import (pages A-1 to A-2 of this manual).

NOTE

In Excel 2007 and 2010, click the Office button in the upper left and 
then click the Excel Options button at the bottom of the window. (In 
Excel 2013, click the File tab then select Options from the menu on the 
left.) Next, select Trust Center from the list at left, then click the Trust 
Center Settings button. Select Macro Settings from the list on the left, 
then choose Disable all macros with notification. Click OK and then 
OK.
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• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the entity does not meet the filing requirement. If this is 
the case, you need to override the default in order to have the amounts shown on 
Schedule L. To force the Schedule L amounts to be printed, go to the PRNT 
screen and select the Force Schedules L, M-1, M-2, & K-1 Section L box.

Figure 32: Force Schedule L box for 1065 package

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail 
(CTRL+W) worksheets that are not required. For example, the IRS does not 
require a detail worksheet for the Gross receipts field on the INC screen; if a 
return has a detail worksheet for that field, the trial balance will not import cor-
rectly into the return. Detail worksheets are indicated by red shading, as shown in 
Figure 33.

Figure 33: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 50 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered 
into Drake’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import in the menu toolbar. The preliminary Trial 
Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.
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4. Click Enable Macros in the Security Warning box that appears.

The trial balance template is displayed in Microsoft Excel.

Naming 
Convention

Whenever a new template is opened, the tax software assigns it a default file location 
and name. Trial balance templates are saved in the TB folder of your Drake13 soft-
ware. The file name consists of the client name as entered in Drake, plus “TB” for 
“trial balance,” plus the “.xls” suffix assigned to all Excel files, as shown in Figure 34.

Figure 34: Example of trial balance template file name

To change the name of a file in Excel, select File > Save As and assign the new name.

Template 
Structure

The trial balance template consists of three title rows and six columns. The Entity 
Name and Year End title rows can be edited; double-click a row to change the title. 
Columns are described in Table 4.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount 
(Figure 35 on page 49; see also Figure 38 on page 51).

NOTE
In Excel 2007 and 2010, you may see a Security Warning message 
with an Options button. Click Options to open the Security Options 
dialog box, then select Enable this content. Click OK. (In Excel 2013, 
click Enable Content.)

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake to which the debit or credit 
amount is imported

Form, Page, Schedule, and/or 
line

Location of the amount on the printed return

Other Information Additional details for preparers; see “Details for Pre-
parers” on page 52.
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Figure 35: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data

Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0). When a new trial balance 
file is opened for a return, all debit and credit amounts are zero ($0). All data must be 
entered manually into the template.

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons (Figure 36).

Figure 36: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 37 on page 50 
shows an example of the “Other Income” worksheet.

NOTE
Some data cannot be imported from the trial balance and must be 
entered directly into the data entry fields within the program. For more 
on these categories of data, see “Special Conditions” on page 52.
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Figure 37: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the Click to return to TB button (labeled 
“1” in Figure 37). Note that a detail tab (the “Other Income” tab in Figure 37) might 
include one or more detail worksheets (labeled “2” in Figure 37). 

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 38).

Figure 38: Out-of-balance amount is highlighted if columns are out of balance.

In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software (see Figure 38).

NOTE
Do not create detail worksheets in data entry if the trial balance work-
sheet does not provide an equivalent detail worksheet. Otherwise, the 
trial balance will not import correctly.

NOTE The data cannot be imported if the worksheet is out of balance.
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Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. To re-name 
a file when saving, select File > Save As. (In Windows 7 and Microsoft Vista, click 
the Office button in the upper left and then click Save or Save As.) For more informa-
tion on file names in the trial balance program, see “Naming Convention” on page 48.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake, the trial balance 
information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 
Trial Balance Import dialog box is opened.

3. Click Next.

4. Enter or select the trial balance file to be imported. Use the Browse feature if nec-
essary. By default, each trial balance file is an Excel (.xls) file showing the client 
name and ending in “TB” for trial balance, as shown in the example in Figure 39. 
(See “Naming Convention” on page 48.)

Figure 39: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional Import 
Options” following this procedure.)

6. Click Next and wait for the import to be completed.

7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

NOTE
Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 52.

NOTE
If you are already in the Trial Balance Import tool for the selected return, 
go to the Trial Balance Import window in Drake and start at Step 3 of 
the following procedure.
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Additional 
Import 

Options

By default, the program imports the following additional information when importing 
the trial balance data:

Special Conditions

Some trial balance items cannot be entered into the trial balance worksheet and must 
be typed directly into Drake data entry. Other items should be entered into the work-
sheet for balance purposes but are not carried to data entry; these must be entered sep-
arately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items go directly to the location indicated in the program and on the 
return. For example, the amounts shown in Figure 40 go to Schedule L, line 1, column 
d in the program and are shown on page 5, line 1, column d of the 1065 return.

Figure 40: Indication of where an amount will go in Drake and on the return

Not all figures can be imported directly, however, and some amounts are optional. 
Drake has provided an “Other Information” column in the trial balance worksheet to 
indicate special conditions and additional information regarding certain rows. Table 5 
describes the most common notes in this column.

Buildings and other depreciable assets Accumulated depreciation

Goodwill and other intangible assets Land

8825/Rent information Accumulated amortization

COGS depreciation

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.

does not import Information cannot be imported and must be entered on the 
appropriate screen in Drake. Screen is specified in the 
“Reported on” column to the left of “Other Information.”

optional Amount is optional; not required for import, but could require 
direct entry in the software.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Schedule A calculation.
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All “does not import” notes are accompanied by further instructions in the column to 
the left of the “Other Information” column, as shown in Figure 41.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not import” on the trial balance. (Figure 41)

Figure 41: SCH2 screen required for “does not import” items

To complete an SCH2 detail screen in data entry:

1. Open the SCH2 screen for the return.

2. Select the line number from the SCH2 drop list.

3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of Schedule L, press PAGE DOWN and repeat steps 
2 and 3. Data is saved automatically upon entry.

When the return is produced, Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screen.

Depreciation Partnership (1065) returns can have up to four components of total depreciation:

• COGS 

• Real estate rental

• Rental other than real estate

• Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that rental expense detail worksheets are 
required for 8825 and RENT depreciation.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Schedule A on the return, and the rental depreciation 
expense amounts flow directly to the appropriate lines of the 8825 and RENT screens, 
as applicable. Because the remaining depreciation can comprise any number of assets, 
the amount entered on the trial balance does not flow to the return. To ensure that each 

NOTE
Enter 8825 and RENT depreciation amounts in the detail worksheets 
for importing purposes, but be aware that the 8825 and RENT screens 
in the program will need to be edited if 4562 detail screens (see 
Figure 42 on page 54) are used.
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component of the total remaining depreciation is calculated into the return, each asset 
must be entered on the applicable depreciation screens in data entry (Figure 42).

Figure 42: Enter depreciable asset data on a 4562 detail screen,
or enter the total depreciation on the override screens

Rental 
Expenses

The following information applies only for partnerships with multiple rental proper-
ties.

The partnership trial balances include lines for rental income and expenses 
(Figure 43). Both rental expense items require a trial balance detail worksheet.

Figure 43: Rental expense rows on a trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears 
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.

2. Enter the income totals on the trial balance sheet and the expense totals on the 
applicable detail sheets (Figure 43).

NOTE

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way 
to check that the amount on line 1 of Schedule M-1 is correct. Compare 
the calculated line 1 at the bottom of the trial balance to the equivalent 
line on Schedule M-1 of the calculated return. If the depreciation 
amounts match but the line 1 amounts differ, an M-1 adjustment could 
be required.
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3. Ensure that the balance sheet is in balance.

4. Import the trial balance worksheet into the return. The applicable screens in data 
entry now contain the figures entered on the trial balance worksheet.

5. Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on 
the calculated return to ensure that they match.

6. Complete all 8825 or RENT screens in data entry, as applicable, for the individual 
rental properties or items.

7. Delete the 8825 and RENT screens that were imported from the trial balance (the 
screens reflecting the total rental expenses).

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item.

For partnerships changing their accounting method, Form 3115 must be attached as a PDF 
file. We have included an EF message that will automatically generate the PDF button on 
the View mode toolbar so that the preparer can attach the form as a PDF. (For instructions 
on attaching a PDF to a return, see “The PDF Attachment Process” on page 43, read the 
Screen Help or the instructions on any PDF screen, or read the “Attaching a PDF Docu-
ment” article on the FAQ screen.)

Drake customers can fill out and e-file certain Forms 3115 and related schedules and 
attachments for partnership returns. This section provides instructions for completing 
this form and related schedules and attachments in Drake.

Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible 
from the Change in Accounting Method box, located under the Other Forms tab of 
the Data Entry Menu.

The screens accessible from the Change in Accounting Method section include:

NOTE
If the amounts do not match, review the imported amounts to ensure 
that all data was imported. If the data appears to have been imported 
correctly, an M-1 adjustment could be necessary.

NOTE
To delete a screen in data entry, open the screen and press CTRL+D. If 
a multiple forms list appears, ensure that the screen to delete is 
selected, then click Delete.

NOTES

In some cases, Form 3115 must still be paper-filed. See “Parts I 
and III,” starting on page 57, for details.

Applicants filing Form 3115 must refer to the Internal Revenue Bul-
letins (available at www.irs.gov) to determine if the IRS has pub-
lished an accounting method revenue procedure, revenue ruling, 
notice, regulation, or other guidance relating to the specific method 
to be changed. See Pub. 538, Accounting Periods and Methods.
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• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 44 
on page 57) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake. The first should be 1, the second 2, and so on. When using 
other screens, such as the 311E or ATT screens, you can use those numbers to indicate 
which instance of Form 3115 the 311E or ATT screen should be associated with; see 
“Screen 311E Multi-form Codes” on page 62 for more information.

Form 3115 Screens

When you open the 3115 screen from the Data Entry Menu, the program displays the 
first of five 3115 screens. These five screens are:

• Parts I, III (Form 3115, Parts I and III)

• Parts II, IV (Form 3115, Parts II and IV)

• A, B, C (Form 3115, Schedules A, B, and C)

• D - I, II (Form 3115, Schedule D, Parts I and II)

• D - III (Form 3115, Schedule D, Part III)

As shown in Figure 44, you can access these 3115 screens by clicking a link at the top 
of any other 3115 screen.

Figure 44: Tab links on 3115 screen

The next few sections of this document provide instructions for completing the vari-
ous screens for Form 3115 (including Schedules A through D).

Parts I and III Use the Parts I, III screen to complete the following sections of Form 3115:

• General Information

NOTE If only one Form 3115 is being submitted, you do not need to enter any-
thing in the Multi-form code box.
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• Part I, Information For Automatic Change Request

• Part III, Information For Advance Consent Request

General 
Information

Complete all applicable fields in the General Information section. Note that the 
fields for business activity and tax-year change are override fields (Figure 45). Com-
plete these fields only if you want to override the equivalent information entered on 
screen 1 or screen K.

Figure 45: Override fields in the General Information sections of the Parts I, III screen

Part I Not all applicants are eligible to use the automatic change request procedures. After 
answering 1a, 1b, and 2 in Part I - Information for Automatic Change Request, 
click the blue Parts II, IV tab at the top of the screen.

Part II In Part II – Information for All Requests, answer question 3 (see Figure 46). If the 
answer is Yes, you are stating that:

• The entity would be required to take the entire amount of the section 481(a) 
adjustment into account in computing taxable income for the year of change.

• Section 4.02(8) of Rev. Proc. 2012-14 applies to the applicant’s accounting 
method change request, and the applicant is therefore not eligible for a change 
under automatic change request procedures. (See IRS Form 3115 instructions for 
details.)

Figure 46: Automatic Change Request information

NOTE Information should be entered in either the Part I section or the Part III 
section, but not both.
Tax Year 2013 57



Form 3115, Application for Change in Accounting MethodDrake Software User’s Manual Supplement: Partnerships
Part III If this section of the Parts I, III screen is filled out, Form 3115 cannot be e-filed with 
the return. It must instead be paper-filed before submitting the return. A user fee (a 
check or money order payable to the IRS) must be included with the paper-filed form.

If the applicant qualifies for a reduced user fee, enter a check mark on line 23b and go 
to screen ATT2 to complete the attachment information for Part III, line 23b (located 
in the bottom half of the screen). Include the necessary information or certification 
required by Rev. Proc. 2012-1 (or its successor).

Specific statements must also be attached to the return if the applicant answers Yes for 
line 18 (“Is change request allowed under automatic change?”) or No for line 22 (“All 
members of consolidated group use proposed method?”). Press F1 in a specific field 
for more information on attachment requirements. The method for attaching state-
ments in Drake is covered in “Attachments,” starting on page 63.

Parts II and 
IV

In addition to the Multi-form code text box, the Parts II, IV screen consists of the 
Part II and Part IV sections, used to complete the following sections of Form 3115:

• Part II, Information For All Requests

• Part IV, Section 481(a) Adjustment

Applicants must complete both sections of this screen. For more information on each 
line (including instructions for any required attachments), press F1 in a specific field.

Part II, Line 12 Note that there is no field on the Parts II, IV screen for Part II, line 12. Fields for line 
12, which should be completed if the applicant is changing only the accounting 
method for a particular item or items, are located in the top half of ATT2 screen. Use 
these fields to enter information on:

• The items being changed

• The applicant’s present and proposed methods for the items being changed

• The applicant’s present overall method of accounting (cash, accrual, or hybrid)

Note that the bottom half of the ATT2 screen is for completing Part III, line 23b. Only 
the top half (for Part II, line 12) needs to be completed for Part II, line 12.

Schedules A, 
B, and C

Use the A, B, C screen to complete the following sections of Form 3115:

• Schedule A, Change in Overall Method of Accounting (screen covers Part 1, 
Change in Overall Method)

• Schedule B, Change to the Deferral Method for Advance Payments

NOTES
See Appendix A of Rev. Proc. 2012-1 for more information. For more on 
applicants who must apply for advance consent, see the IRS Form 
3115 instructions.

Taxpayers filing under an automatic change request procedure do not 
pay a user fee.
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• Schedule C, Changes Within the LIFO Inventory Method (screen covers both Part 
I, General LIFO Information, and Part II, Change in Pooling Inventories)

Schedule A This section is required for all applicants filing to change their overall method of 
accounting. It requires the entry of amounts as they were at the close of the tax year 
preceding the year of the requested change.

The IRS requires a worksheet for lines 1a, 1c, 1d, 1e, and 1f of Schedule A. When you 
enter an amount on any of these lines in Drake, a Ctrl+W worksheet is automatically 
opened, allowing you to begin entering the descriptions and amounts of multiple items 
for the worksheet. When you close a Ctrl+W worksheet, the program returns to the 
original screen and displays the total in the field. The field is shaded (default is red) to 
indicate that a Ctrl+W worksheet has been used. 

Schedule B This section has just two lines, both referring to the request for deferral for advance 
payments:

• Line 1 — Request change to the deferral method for advance payments (from sec-
tion 5.02 of Rev. Proc. 2004-34)

• Line 2 — Request change to the deferral method for advance payments (from sec-
tion 1.451-5(b)(1)(ii))

See IRS Form 3115 instructions for more information on making these requests.

Schedule C This section has two parts:

• Part I (General LIFO Information) — This section is made up of attachment links 
(see Figure 51 on page 63). If any of the conditions on lines 1–6 match the entity’s 
situation, click the corresponding attachment link to access the ATT screen, 
where you can complete the required statement. (Select the corresponding line 
code from the Schedule drop list on the ATT screen.)

• Part II (Change in Pooling Inventories) — Enter the descriptions of the contents 
and the base years of the present and proposed pools. If any of the conditions on 
lines 2–4 match the entity’s situation, click the corresponding attachment link to 
access the ATT screen, where you can complete the required statement.

NOTE
Schedule A, Part II (Change to the Cash Method for Advance Consent 
Request) requires attachments and is not addressed on the A, B, C 
screen.

NOTE
Leave blank any lines that aren’t required for the entity’s application. 
Exclude amounts not attributable to the change in method of account-
ing—for example, amounts that correct a math or posting error, or that 
correct errors in calculating tax liability.

NOTE If nothing is entered in a Schedule A field, the program automatically 
displays the word “NONE” in the field on the generated form.
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Schedule D, 
Parts I and II

Use the D - I, II screen to complete the following parts of Form 3115, Schedule D, 
Change in the Treatment of Long-Term Contracts Under Section 460, Inventories, or 
Other Section 263A Assets:

• Part I, Change in Reporting Income From Long-Term Contracts

• Part II, Change in Valuing Inventories Including Cost Allocation Changes

Schedule D, 
Part I

A long-term contract refers to any contract for the manufacture, building, installation, 
or construction of property that is not completed in the tax year in which it is entered 
into. Answer the questions in Part I that apply to the entity’s situation.

Schedule D, 
Part II

This section concerns changes in the identification and valuation methods of invento-
ries. Note that some lines require attachments. To access the ATT screen and complete 
a required statement, click the desired attachment link.

The items on this part of the screen match the items on the actual Form 3115, Sched-
ule D. For information on completing individual lines, see the Form 3115 instructions.

Schedule D, 
Part III

Use the D - III screen to complete Part III (Method of Cost Allocation) of Form 3115, 
Schedule D. Part III is required for any entity submitting either Part I or Part II. Screen 
D - III consists of the following sections:

• Section A, Allocation and Capitalization Methods

• Section B, Direct and Indirect Costs Required to be Allocated

• Section C, Other Costs Not Required to be Allocated

Section A Click the D3-1 Attachment link (see Figure 47) to attach a description of the present 
and proposed methods used to capitalize direct and indirect costs.

Figure 47: Link to ATT screen for attaching statements

Sections B 
and C

These sections consist of a series of drop lists under a Present column and a Proposed 
column. “Present” refers to the current accounting method, while “proposed” refers to 

NOTE
If an entity is currently using a LIFO inventory method or submethod 
and is changing to another LIFO inventory method or submethod, Part 
II of Schedule D is not applicable. Use Schedule C, Changes Within the 
LIFO Inventory Method, instead.

NOTE

If the entity is unable to furnish a copy of Form 970 (line 5a), the attach-
ment must include the following statement:

“I certify that to the best of my knowledge and belief (name of applicant) 
properly elected the LIFO inventory method by filing Form 970 with its 
return for the tax year(s) ended (insert date(s)) and otherwise complied 
with the provisions of section 472(d) and Regulations section 1.472-3.”
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the requested change in accounting methods. You should address only the items neces-
sary; do not make a selection for any item for which an answer is not required for the 
entity’s situation.

For each item in sections B and C, you can:

• Select X — If you select X, the corresponding box on Form 3115 will be marked 
with an X. (See Figure 48.)

• Select B — If you select B, the corresponding box on Form 3115 will be left blank 
and an attachment will be required explaining why the line was left blank. (EF 
messages will outline which statements are missing.

• Select nothing — If you select neither of the above options, “N/A” will appear in 
the corresponding box on Form 3115. No attachment is necessary for a box 
marked “N/A.”

Figure 48: X was selected for column 1, lines 1-3; B was selected for column 1, line 4;
nothing has yet been selected for any other line. (See also Figure 49.)

To attach a statement for section B or C, click the D3-2 Attachment link at the top of 
Section B. (See Figure 49.) A single statement may contain all necessary explanations 
for sections B and C.

Figure 49: If any box is marked “B,” click the D3-2 Attachment link to open
the ATT screen and complete the fields for an attached statement.
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Schedule E

Use screen 311E, accessible from the Change in Accounting Method section of the 
Other Forms tab, to complete Schedule E, Change in Depreciation or Amortization.

Screen 311E 
Multi-form 

Codes

Unlike the other 3115 screens, screen 311E contains two multi-form code text boxes:

• Multi-form code for 3115 — This box is applicable if the return contains more 
than one Form 3115. Enter the code for the instance of the 3115 screen with which 
this 311E screen should be associated.

• Multi-form code for Sch E — This box is applicable if the return contains more 
than one Schedule E. (A separate 311E screen should be used for each property.) 
Assign each property a separate code in its Multi-form code for Sch E. This code 
enables you to associate any attachments with the correct Schedule E property. 
(See “Attachments,” following.)

If the return contains more than one Form 3115 and multiple instances of Schedule E, 
both multi-code fields should contain numbers. Figure 50 shows that the third instance 
of a Schedule E is to be associated with the second Form 3115 in the return.

Figure 50: Example of third instance of a Schedule E to be associated
with the second instance of a Form 3115.

Completing 
Schedule E

The 311E screen consists of four sections:

• Schedule E - Line 4a — Enter information on the type of property, the year it was 
placed in service, and the property’s use.

• Schedule E - Change in Depreciation or Amortization — This section covers 
all Schedule E items other than lines 4a and 7. Note that lines 5 and 6 are links to 
required attachments.

• Schedule E - Line 7 - Present Method and Schedule E - Line 7 - Proposed 
Method — For the line 7 sections, enter information on the Present Method and 
Proposed Method in the supplied text boxes and choose the applicable conven-
tion from the Applicable Convention drop list. Options are as follows:

NOTE
If changing this method under the automatic change request proce-
dures, see the “List of Automatic Accounting Method Changes” in the 
IRS Form 3115 instructions.

• HY — Half-Year • MM — Mid-month

• MQ — Mid-quarter • S/L — Straight line
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Attachments

Attached statements are required for many Form 3115 items. Depending on the nature 
of the attachment, you will attach statements to the form in one of two primary ways:

• From Data Entry — The ATT screen is the most common screen for attaching 
statements to Form 3115. The ATT2 screen is used for Part II, line 12, and Part 
III, line 23b. (See the “Parts I and III” and “Parts II and IV” sections of this docu-
ment for more information on completing the ATT2 screen for these items.)

• From View mode — Used for PDF attachments.

 ATT Screen 
Attachments

There are two ways to access the ATT screen in Drake:

• From the Data Entry Menu — In the Change in Accounting Method section of 
the Other Forms tab, click ATT.

• From the line that requires an attachment — As shown in Figure 51, some 
lines have attachment links. Click an attachment link to open the ATT screen.

Figure 51: Attachment links from Schedule C (screen A, B, C)

Complete the following ATT fields, as applicable, for all ATT screen attachments:

• Multi-form codes — Use these boxes to associate the attachment with an 
instance of Form 3115 (if the return contains more than one), a particular Sched-
ule E property (if the return contains more than one Schedule E), or both. (See 
“Multi-form Codes” on page 56 for more information on multi-form codes.)

• Schedule — Select the line of the form or schedule with which the attachment is 
to be associated. If an item begins with a number, it refers to the part of Form 3115 
(for example, 2-4e refers to Part II, line 4e). If it begins with a letter, it refers to a 
particular Form 3115 schedule (for example, C2-b refers to Schedule C, line 2b; 
C2-5 refers to Schedule C, Part 2, line 5).

• Explanation — Enter the statement explanation. If the explanation requires more 
than 900 characters, press PAGE DOWN for a second screen.

NOTE
Not all lines that require statements include a link to the ATT screen. 
Always check the field-level help (click F1 in a field) to determine if a 
statement is required. The program produces an EF message if any 
required statements are missing.

NOTE
If the explanation requires more than seven screens, only the first 
6,500 characters of the explanation are transmitted with an e-filed 
Form 3115. There is no character limit for paper-filed returns.
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Additional 
ATT Fields

The ATT screen has a separate section, to be used only for Part II, line 10 (“Does the 
applicant... have pending any request... for a private letter ruling, change in accounting 
method, or technical advice?”). The IRS requires that the attached statement, in addi-
tion to providing an explanation, include the taxpayer’s name and ID number. Enter 
the name and ID number, and indicate if the ID number is an EIN, in the applicable 
fields at the bottom of the ATT screen (Figure 52).

Figure 52: Special section for entering taxpayer name and ID number
for Part II, line 10; located at bottom of the ATT screen

PDF 
Attachments

Some Form 3115 items require the attachment of documents that cannot be created in 
Drake Software; for example, line 4d of Part II requires written consent from a direc-
tor. You can, however, attach such a document to the form as a PDF.

Directions for generating and attaching PDF documents can be found on the PDF 
screen in Drake Software. Directions for converting other types of documents into 
PDF are available by clicking the Screen Help button at the top right corner of the 
PDF screen. Copy or print these instructions as desired. Also see “Binary Attach-
ments” on page 43 of this document. 

When the return is generated, an “EF Attachments” worksheet is produced. (See 
Figure 53 on page 65.) This worksheet shows, in table format, the Reference (section 
of Form 3115), the Description, and the IRS-required Filename of each required PDF 
document. This worksheet is displayed as EF_PDF~ in View mode.

NOTE
Once attachments have been filled out, accessing the ATT screen will 
display Existing Forms List of all attachments created. Select the 
attachment (or click the blue New line to create a new attachment), 
and then click Open.

NOTES

Do not enter data on the PDF screen itself. If using the directions pro-
vided on that screen, skip Step 2, which instructs you to fill out the col-
umns at the bottom of the PDF screen.

A PDF document may be attached using any filename. When you 
attach the document, the program automatically assigns it the filename 
required by the IRS.
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Figure 53: Example of an EF Attachments worksheet

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF messages (as applicable) when the return is calculated. All forms, schedules, EF 
messages, and worksheets are accessible from View mode.

EF messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen and the EF_PDF~ worksheet to the list on the EF message 
page.

NOTE
All EF messages must be eliminated before the return is eligible for 
e-file. EF messages for Form 3115 attachments are eliminated when all 
required statements have been attached to the return.
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Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a partnership tax return from a 
trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
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Trial Balance Import: General Process

Process
complete!

Go to data entry an 
enter individual 

rentals on 8825 or 
RENT screens as 

applicable

Delete imported 
8825 and RENT 

screens

1120S & 1065:
Were rental totals entered 

in trial balance?

YES

NO

M‐1 
ent

1120 
return? NO
Populate Trial Balance 
Template

(Import > Trial Balance Import)

‐ direct entry data (cells with $0)
‐ applicable detail worksheets
‐ totals for:

‐ depreciation
‐ Schedule L
‐ rentals (1120S & 1065 only)

Compare M‐1, line 1: Does trial balance 
match Schedule M‐1, line 1?Prepare to use Trial 

Balance Import

‐ Enable Excel macros
‐Disable autobalance
‐ Force Schedule L
‐Delete unnecessary detail worksheets

Did data
import 

correctly?

Make 
corrections in 
TB worksheet

NO

NO

Is an M‐1 
adjustment 
necessary?

Adjust 
amounts 

elsewhere in 
data entry

YES

Make 
adjustm

I
M
P
O
R
TPopulate Data Entry

Enter any trial balance data that cannot be 
imported via Trial Balance Import

‐ Screen SCH2 for Schedule L items
‐ Screen 4562 for individual assets

        (depreciation)

YES

NOYES

990, 990‐EZ, or 
990‐PF return?

YES

NO
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Index

Numerics
179 allocation overrides 4
52-53-week year returns 41

A
accounting method

changing 42, 55
entering on 1065 6

accrual (accounting method) 6
address

change of 6
entering on Form 1065 5
foreign 22
on K-1 letter heading 27
out-of-state 20

adjusted basis worksheet 23, 24–25, 39
adjustment fields 40
adjustment fields, guide to 20
adjustments

depreciation 31
to income and expenses 36

allocations
section 754 26
special (screen SA) 22, 25

alternative minimum tax (AMT) 20
amending

a 1065 return 6, 15
and TEFRA audit rules 16
K-1 letters 28

amortization 13, 14, 29
analysis

of capital accounts (Schedule M-2) 33
asterisks (on K-1 codes) 22
attachments

binary 43–46
Form 8825 35
to Form 3115 56, 60, 62

auto-balance 30, 40

B
bad debts 9, 10
bankruptcy returns, e-filing not allowed for 41
basis 24–25

see also adjusted basis worksheet
book-to-tax differences (Schedule M-1) 31–32
business activity codes 6

C
calendar year returns 5, 14
cash (accounting method) 6, 10, 59
change

of name or address 6
charitable contributions 7
Client Communications Editor (for letters) 28
codes

business activity 6
error/reject 42
K-1 22, 39
miscellaneous (screen 1) 20
multi-form 34, 56, 62, 64

compensation of partners 9
contact information (for state returns) 18
contributions, charitable 7
cost of goods sold, see  Schedule A (Cost of Goods Sold)
cover letters (K-1) 27
coversheets 40
credits 8, 14, 36
Ctrl+W (detail) worksheets 7, 9, 47, 59

D
data entry

for state information 18
importing trial balance into 46–55
state tabs in 18

dates
business start 6
tax year 5

decrease to basis 25
deductions 9–14, 27
depletion 13
depreciation

entering 11–13
for cost of goods sold (Schedule A) 7
of rentals 11, 33
on short-year returns 5
printing Form 4562 39
trial balance (business returns only) 53

detail (Ctrl+W) worksheets 7, 9, 47, 59
domestic production activities deduction 27
due dates 14

E
e-filing 41
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Form 8879-PE 15
PDF attachments 43
statements 29

electronic signatures (PIN) 14
employee benefit plans 13
envelope coversheets 40
error codes 42
expenses 9–14
exporting K-1 data 23
extensions 14, 40

F
farm profit or loss 8
filing instructions 40
final return 6
fiscal year returns 5
foreign

addresses for partners 22
ownership 16
transactions 20

Form 3115 (Application for Change in Accounting Meth-
od) 42, 45, 55–65

Form 4562 (Depreciation and Amortization) 33, 39
Form 4797 (Sales of Business Property) 8
Form 5884 (Work Opportunity Credit) 37
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)

8, 36
Form 6765 (Credit for Increasing Research Activities) 14, 

37
Form 7004 (Application for Automatic Extension of Time 

to File) 14
Form 8082 (Notice of Inconsistent Treatment or Amended 

Return) 16
Form 8820 (Orphan Drug Credit) 14, 37
Form 8825 35
Form 8825 (Rental Real Estate Income and Expenses of a 

Partnership or an S Corporation) 33–36
Form 8844 (Empowerment Zone and Renewal Community 

Credit) 37
Form 8845 (Indian Employment Credit) 37
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 10, 37
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit)

8, 36
Form 8873 (Extraterritorial Income Exclusion) 14
Form 8879-PE (IRS e-file Signature Authorization for 

Form 1065) 15
Form 8881 (Credit for Small Employer Pension Plan Start-

up Costs) 37
Form 8893 (Election of Partnership Level Tax Treatment)

39
Form 8903 (Domestic Production Activities Deduction) 27
Form 8912 (Credit to Holders of Tax Bonds) 36

Form 8912 (Credit to Holders of Tax Credit Bonds) 37
Form 8916A (Supplemental Attachment to Schedule M-3)

32
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 37
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 14
Form T (Forest Activities Schedules) 13

G
gains and losses 8
gross receipts 7
guaranteed payments 9

H
header information 5
health insurance 13
health savings account (HSA) 10

I
importing trial balance 46–55
inactive returns 42
income 6–9
increase to basis 25
instructions for filing 40
insurance

and contributions to benefit plans 13
entering deductible payments for 10
proceeds, income from 9

interest
expense 11
income 9
ownership of (Schedule B) 16–17

inventory (on Schedule A, Cost of Goods Sold) 7
IRAs 13
Item M (on Schedule K-1) 24

K
K-1, Schedule for 1065 21–24

L
letters (K-1) 27

M
M, item (on Schedule K-1) 24
maintenance costs 10
medical care for employees 13
Multi-State Apportionment 18
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N
name change 6
name control reject 43
net

farm profit or loss 8
gain or loss 8

next-year depreciation listing 39
number of partners 6

O
ordinary gains and losses 8
other

costs (Schedule A) 7
income (loss) 8

overrides 40
guide to 20
of calculations for partners 22
on screen 1 20

ownership
of interest (Schedule B) 16

P
partners

compensation of 9
foreign addresses for 22
guaranteed payments to 9
health insurance for 13
number of 6
returns with numerous 22
Schedule K-1 21
special allocations for 25
updating data annually 25

partnership, termination of 6
payments, guaranteed 9
PDF 44
PDF documents, e-filing 43–46
PIN (electronic) signatures 14
printing

1065 returns 38
adjusted basis worksheets 39
cover letter for K-1 27
force 38
Form 8903 for each partner 27
K-1 items 22
suppressing/forcing documents 39

prior-year returns, updating 4

R
real estate 54
receipts 7
refunds, state 9

reject codes 42
rent paid on business property 10
rental activities 33–36
repair costs 10
resident state 18, 20
retirement plans 13
returns

52-53-week year 41
bankruptcy 41
extensions for 14
fiscal and calendar year 5
inactive 42
short-year 5
signing 14
tax-exempt organizations (990) 43–46
updating prior-year 4

S
scanning attachments for e-filing 43
Schedule A (Cost of Goods Sold) 7–8
Schedule B (Other Information) 16
Schedule D, Form 3115 60
Schedule E (Change in Depreciation or Amortization) 

(Form 3115) 62
Schedule E, Form 3115 62
Schedule K (Partners’ Distributive Share Items) 6, 20
Schedule K-1 (Partner Information) 21–24
Schedule L (Balance Sheet per Books) 28–30, 39
Schedule M-1 (Reconciliation of Books With Return) 39
Schedule M-1 (Reconciliation of Books) 30
Schedule M-2 (Analysis of Capital Accounts) 33
Schedule M-3 (Net Income (Loss) Reconciliation) 32
section

179 13, 25
481 9
754 12, 26

Selector field 2
self-employment income 36
SEP or SIMPLE plans 13
short-year returns 5
signatures, electronic 14
special allocations (screen SA) 22, 25
state

overriding information related to 20
resident 18
tabs in data entry 18
tax refunds 9

state-specific information 18

T
tax

returns, see returns
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years (fiscal vs calendar) 5
Tax Equity and Fiscal Responsibility Act (TEFRA) 16
taxes and licenses 10
technical termination 6
termination of partnership 6
trial balance import

and depreciation 8
and SCH2 screens 30
instructions for using 46–55

U
updating

a prior-year return 4
partner data annually 25

V
Vista (Windows operating system) 51

W
wages 9
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